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Preface

This manual supports the following Windows™ 95, 98, 2000, and
NT 4.0 versions of WaveStar ™ software products:

m  WSTRO WaveStar Software for Oscilloscopes

m  WSTROU Upgrade to WaveStar Software for Oscill oscopes from
WSTR31 (WaveStar for Windows 3.1 software)

Thismanual is organized to cover all common information about
WaveStar Software, and al so includes specific information for each
product where applicable.

Thismanual describes system requirements, installation, operating
basics, data sheet overview and procedures, RS-232 and GPIB
reference information, the WaveStar Instrument Manager Service,
and the WaveStar User Table Proxy application. Refer to the online
help for further information on the topicsin this manual and for
information on the user interface and advanced procedures.



Thefollowing table lists al of the documents included with your
purchase and the purpose of each document.

Documentation Set

Document

Purpose and description

ilaa

#a laa ha @ h aa
B 1aig i1 aal
aifhothiaaigh
thheh

rihi# Bag hza
ahalaghhaiih

age

ffia: K:

a haa a thaa: ffia
iaal i hataiqei s he
i hifia Yiftaite
hiiah i hifa i
rraiia hfiathi ]
th at

a1 al taa
fiau fiiah 1 hifl

Beia




Contacting Tektronix

Phone il *

Address

Web site m

Salessup-  Hzn. *
port

Service
support

Technical ia: 1@m
support _

fla=tiafis

*  This phone number is toll free in North America. After office
hours, please leave a voice mail message.

Outside North America, contact a Tektronix sales office or
distributor; see the Tektronix web site for a list of offices.
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Product Description

WaveStar Software introduces afamily of Windows 95, 98, and
NT 4.0 applications that connect your Tektronix TDS/THS and CSA
oscilloscopes to your PC desktop.

Capture

The WaveStar software provides the following features for setting up
and capturing data:

®  Set up communication to instruments through the WaveStar
Connection Wizard.

m  Usethe WaveStar Explorer view to display connected instru-
ments and capture measurement waveforms and data easily
without the need for programming.

®  Drag and drop instrument data into an active data sheet.

Analyze

The WaveStar software provides the following features for data
analysis:

m  Analyze, annotate, and record information in avariety of data
sheets.

m  Capture and graphically view multiple waveforms on a graticule
with the same scale and position as on the oscilloscope.

®m  Take measurements easily using cursors, gates, and zoom.
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Product Description
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Control
The WaveStar software provides the following control features:

m  Step away from your desk and have WaveStar automatically
capture data changes.

m  Establish instrument links to automatically update new
measurements.

m  Control waveform information locally or over the network.

Document

The WaveStar software provides the following documentation and
print features:

m  Archiveinformation in Microsoft Office or other Microsoft
Windows applications.

®m  Print banner function allows printing of long record length
waveforms.

Create Masks

The WaveStar software provides the following mask creation
features:

®  Copy and load instrument test masksto or from YT data sheets.
m  Edit masksin an intuitive, easy-to-use graphical editor.

m | oad test masks from the WaveStar Mask Library.

m  Create masks from scratch.

Distribute

The WaveStar Reader software provides the following features:

= Open, view, and manipulate existing WaveStar notebook and data
sheet files.

®  You can load WaveStar Reader onto as many PC'sasyou like.

® You cannot create new data sheets. You can save existing data
sheets and notebooks to new file names.

®  You cannot link WaveStar Reader to an instrument.
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System Requirements

Toinstall and run WaveStar software, you must have an IBM-com-
patible PC with the following installed:

Microsoft Windows 95, Windows 98, Windows 2000, or
Windows NT 4.0

16 MB RAM or greater recommended
CD-ROM drive, 4X or better

Super VGA monitor or better

20 MB of disk space

Available RS-232 COM port

If you are using WaveStar Software for Oscilloscopes with GPIB
communications, you will also need a National Instruments
|EEE-488.2 GPIB Interface Card, GPIB driver software (usually
included with the GPIB interface card), and a GPIB cable.

When using the Tektronix AD007 GPIB-LAN Adapter, you can
connect directly to the 10BaseT LAN (local area network) connector
with aRJ-45 UTP cable (provided with your AD007 GPIB-LAN
Adapter). For acomplete list of the system reguirements for the
ADO0O07 Adapter, refer to your ADOO7 GPIB-LAN Adapter User
Manual.far
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Supported Instruments

For alist of supported products, please see the booklet insert
included with the CD-ROM.
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Installation and Uninstallation

This section describes how to install all WaveStar software products.

Installing WaveStar Software

|| 71 . Toinstall the WSTRO software, you must have the 14-charac-
ter code. The code is on a label on the back of the CD installation
manual in the CD case.

If you are installing the WSTROU (WaveStar Software Upgrade from
WSTR31 (WaveStar for Windows 3.1), you must have the serial
number from your WSTR31 WaveStar Software. The serial number is
on the WSTR3L1 floppy disks and on the label on the WSTR31
Software License Agreement Envelope.

Follow the steps below to install WaveStar software.

1. Insert the CD-ROM into the CD-ROM drive. Typicaly, the
CD-ROM drive will run automatically. If it does not, run the
Install.exefile located in the CD’s root directory.

The main installation screen shows colored tabs, one for each
WaveStar-associated product. Each product tab provides product
overview materia and an installation program. WaveStar for
Oscilloscopes aso provide atutorial.

2. Select thetab for the product that you want to install. For
example, to install WaveStar for Oscilloscopes, click the
WaveStar for Oscilloscopestab. Theinstaller displaysthe
selected product’s screen, with amenu bar at the top of the
installer screen.
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Install ation and Uninstallation

3. Click Install in the menu bar. The installation wizard appears

next. Theinstructions in the wizard guide you through the
process of installing the following WaveStar software compo-
nents:

m  Microsoft DCOM (only installed if not present)
®m  Microsoft winsock2 (only installed if not present)
m TekVisa

m  WaveStar for Oscilloscopes or WaveStar Reader

Microsoft DCOM Installation

| 71 . Theinstallation programwill only install DCOM if it is not
already installed on your PC.

4. Theinstallation wizard will tell you that Microsoft DCOM for

Windows must be installed on your machine. DCOM isa
Microsoft software application that WaveStar software requiresto
interact with Microsoft applications. Click Next.

. Read the Microsoft DCOM for Windows License Agreement. If

you accept al of the termsin the license agreement, click Yes. If
you do not accept the terms of the agreement, click No to end the
setup process. If you do not install DCOM, WaveStar may not be
ableto interact with Microsoft Office programs such as Word and
Excel.
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Install ation and Uninstallation

TekVisa Installation

You will be prompted to install TekVisa software, which includes the
Tektronix version of Visa32.dll. Visa32.dll is acomponent that
WaveStar needs to communicate with your instruments.

The WaveStar installer detects if you have another version of
Visa32.dll aready installed on your PC. You can choose to use the
existing version, or you can replace the existing version with the
provided TekVisa. If you are using Visa32.dll with other programs,
refer to VISA on page 1-10 for information on TekVisa.

If you already loaded the TekVisa software as part of the TDS3EM
or AD0O7 installation, you do not need to install the TekVisa
software during the WaveStar installation.

Do these stepsto install TekVisa software:

6. The Tektronix VISA installer starts. Click Next when you have
read the preliminary information.

7. Inthe Choose TekVisa Destination Location dialog, select the
location of the TekVisa software:

m  Click Next to accept the default location (recommended).
OR

m  Enter the directory location where you want Tektronix VISA
installed and then click Next

8. Inthe Choose VXI Plug & Play Destination Location dialog,
select the location of the V XI software:

m  Click Next to accept the default location (recommended).
OR

m  Enter the directory location where you want TekVisa VXI
Plug and Play componentsinstalled and then click Next.
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Install ation and Uninstallation

9. Inthe Setup Type dialog, select the type of installation you would
like to perform and then click Next.

m  Full Setup Typeinstalls al required VISA files (recom-
mended).

OR

®m  Custom Setup Type alows you to choose which components
to install.

10. The Start Copying Files dialog displays the directory location of
where VISA and VXI Plug and Play fileswill beinstalled.

m |f thisinformation is correct, click Next.
OR
® |f you want to change this information, use the Back button.

11. When the TekVisainstallation is complete, the Setup Complete
dialog appears. Click Finish to dismiss this dialog and proceed to
install the WaveStar software.

WaveStar for Oscilloscopes/WaveStar Reader Installation

12. The Welcome to WaveStar dialog appears. Read the information
inthe dialog, and click Next.

13. Read the WaveStar Software License Agreement.

m |f you accept al of the termsin the license agreement, click
Yes.

OR

® |f you do not accept the terms of the agreement, click No to
end the setup process.
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Install ation and Uninstallation

14. The installation program next displays the installation type dialog
box. Make your selection and then click Next:

m  Select WaveStar for Oscilloscopes to load WaveStar for
Oscill oscopes Software.

OR

m  Select WaveStar Software DEMO to load and run WaveStar
for a30-day trial period. If you are loading the demo
software, please go to step 16.

OR

m  Select WaveStar Reader to load and run the WaveStar
Reader program. WaveStar Reader lets you open and
mani pulate existing WaveStar data sheet and notebook files,
but does not connect to any instruments or let you create new
data sheets. You can load WaveStar Reader onto as many
PC’s as you want. If you are loading the reader, please go to
step 16.

15. The User Information dialog appears next. Enter your name,
company, and the software key code, then click Next. The
14-character software key code is found on the back of the
CD-ROM installation manual.

If you areinstalling WSTROU, the installer requires you to also
enter the serial number of your WSTR31 software. The serial
number is on the WSTR31 floppy disks and on the label on the
WSTR31 Software License Agreement Envel ope.

16. The Registration Confirmation dialog appears, asking you to
confirm the registration information.

m |f theinformation is correct, click Yes.
OR

®m |f you need to change any information, click Back and
re-enter the information.

17. 1f you have already installed a WaveStar product, go to step 19.
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Install ation and Uninstallation

18. The Choose Destination L ocation dialog appears, asking you to
select adirectory location for the WaveStar software files.

m  Click Next to accept the default location (recommended).
OR
m  Enter alocation other than the default, and then click Next.

19. After dl the files have been installed, the Restart Windows dialog
appears. Click OK. It is recommended that you restart Windows
to alow the proper operation of WaveStar software.

Uninstallation

To uninstall WaveStar for Oscilloscopes software, select Start >
Programs > WaveStar for Oscilloscopes > Uninstall. You can also
use the Add/Remove program in the Microsoft Windows Control
Panel. Both uninstall methods activate the Uninstall wizard, which
takes you through the uninstall process for the selected software.

Tutorials

VISA

1-10

Theinstallation disk contains tutorials for WaveStar for Oscillo-
scopes. The tutorialsintroduce you to key features and functionality
of the WaveStar software. To run the tutorial, insert the WaveStar
CD into the CD drive and then select Start > Programs >
WaveStar for Oscilloscopes > Tutorial.

TekVisaisthe Tektronix version of VISA software. Typicaly, only
one version of VISA runson your computer at atime, so you must
choose between TekVisaand a VISA from another company. If you
choose to overwrite the existing Visa32.dll file, theinstaller deletes
any other Visa32.dll filein the System directory of Windows and
replacesit with TekVisa's Visa32.dll file.

To use two different Visa32.dll files, simply rename the Visa32.dll
file you want to replace, and copy the Visa32.dll file you want to use
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Install ation and Uninstallation

to the same location. For example, you have two VISA files (one
from National Instruments, one from Tektronix), and the current
VISA fileisthe National Instruments (NI). To replace the NI VISA
file, rename it Visa32_ni.dll, and copy the TekVisa Visa32.dll file
into the Window’s System directory. A copy of TekVisa's Visa32.dll
islocated in the directory where TekVisawas stored.

Note the following information when choosing between TekVisa and
another company’s VISA:

m The ADOO7 GPIB-LAN Adapter requires VXI-11 interface
components, which are loaded as part of the AD007 TekVisa
installation process. Therefore, if you are using an AD007
GPIB-LAN Adapter, you must either install the TekVisa
components from the AD0Q7 installation process, or do a custom
WSTRO install and select all available componentsto install.

m  The Tektronix TDS3EM Ethernet communications module for
the TDS3000 Series oscilloscopes requires that you install the
TekVisa components. If you did not install the TekVisa
components as part of the WSTRO installation, run the WaveStar
installation program and select the TDS3EM tab at the top of the
screen.

®  The WaveStar software may work with a VISA from another
company, provided their VISA software supports the interface
types with which you are working. If you choose to use a VISA
from another company and find it doesn’t work with the
WaveStar software, you can install TekVisalater using the
WaveStar installer.

m  TekVisadoes not support VXI Mainframe communication.
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Instrument Manager

The Instrument Manager application connects your PC to an
instrument. Any connections you make will be saved when you exit
the Instrument Manager.

Main Screen

Theillustration below shows the Instrument Manager main screen.

Tektronix [nsiriEeid Makaper Sendce

Covtrol Edt View Prek Heb
1:1|P|:~:|ﬁl| Er|i| 1'|Iﬁ'|
= Dok, Tho 30 ASALT::INSTR Ha! Offline

ﬂ TeDmm BERL1-INSTR Ay Rurrirg Fespording
Faady | Sarvice |5 Aurning <l
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Instrument Manager

Menu Bar

The menu bar contains five menus, each with submenu commands to
control the application.

Control
Refresh Lists ifth he s ¢ al ras b
miafam
Auto Shutdown ifg: h ajar 1 avaid
thik

Connect Service ffge hi

Shutdown Service  hithm

Exit User Interface & h i laag;

Edit
Add Instrument Aramihilaag !

Instrument
Properties

Delete Instrument k&

Switch Instrument
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Instrument Manager

View
Toolbar lihiara ff
Status Bar Ithiaaaff
Activity Log lthajgiiaff h
algthatadf
makhlah
Print
Activity Log ihaig
Help

Contents and Index fahiaifzasfh
thi

What's This

InstMgr Overview

Technical Support  hifias airaig | 2 f
thial hi

About InstMgr by s fas fi b
laag

WaveStar Software User Manua 2-3



Instrument Manager

Toolbar

The Instrument Manager toolbar contains buttons that operate as
shortcuts to certain menu commands. Shown below is each button
with a description of what the button controls.

ol x|et| 2la| 2w

1 2 3 4 5 6 7 8

1 namm

2 ihepfhus
fiht

3 thmihwefht

4 lgghdrnetal
fiiYighwhlan

5 lahiwlaagailg haigi
Tal 1t

6 thwlaag ailg

7 Aihieh

8 ialha D hihirfasan:
thitahiihieef
hhia hi

Instrument List (Main Screen)

The main screen of the Instrument Manager (see page 2—1) shows
all the instruments available for connection and the following
information (from left to right):

m Thealiasyou have assigned each instrument (if available)
®m  The connection type (RS-232, ASRL, or GPIB ports)
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Instrument Manager

m  The permissions set for each connection

m  Software status (running, not running) and hardware status
(responding, not responding)

Add Instrument: RS-232 Connected

Once you have connected the new instrument to the PC using the
appropriate RS-232 cable, follow the steps below to use the
Instrument Manager Service (IMS) to set up communications
between the instrument and the PC.

1. Power on the instrument.

2. OpentheIMS application and click the Add toolbar button or
select Edit | Add Instrument...

3. When Step 1 of the Instrument Connect wizard appears, select
your instrument from the list, and click Next.

4. Step 2 listsall available RS-232 connections between the PC and
your instrument. Note that ASRL isthe same as an RS-232 COM
port. Select the desired connection, and click Next.

|| 71 If thereare no listings, there are no RS-232 connections
available. You should recheck your instrument-to-PC communication
cable and make sure the instrument power is on. You should also
make sure no other applications are using the RS-232 connection.
Finally, refer to section RS-232, which starts on page 7—1, for more
RS-232 information.

5. Step 3letsyou enter an alias for your instrument. Thiswill be the
name that appearsin the IMS Aliaslist and in the WaveStar
Software instrument explorer view. If you do not enter a name,
the product family name is used by default. Enter an alias or
leave the field blank, and click Next.

6. In Step 4, click Configure to change your connection settings. If
you click Configure, adialog appears showing the following
settings (click Next to use the current RS-232 settings):
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Instrument Manager

Baud. The Baud rate is the speed of communication between
your PC and instrument. The baud rate selected here must match
the baud rate of the instrument to which you are connecting.

| | 7. You can connect TDS 3000 oscilloscopes at a maximum baud
rate of 38,400; all other instruments are limited to a maximum baud
rate of 9,600.

Stop bits. Stop bits are the number of bits sent with each
character to identify the end of datafor that character.

Data bits. Data bits are the number of bits sent for each
character.

Flow control. Flow control is the type of handshaking used to
guarantee accurate transmission of datafrom one deviceto
another. This handshaking prevents buffers from overflowing in
the receiving device.

Parity. Parity isthe data bit added to each character to validate
its correct transmission.

Terminator. Terminator is the character added to the end of each
command or query to indicate the end of the command or query.

Timeout. Timeout is the length of time the application will try to
communicate with the instrument before aborting the commu-
nication. The default setting is None, which each instrument
interprets differently.

Restore Factory Settings. Usesthe RS-232 settings originally
shipped with the selected instrument.

Restore Default Settings. Uses the predefined default settings
for the selected instrument.

When you are finished configuring the settings, click Test New
Settings. If the settings are accepted, a dialog appearstelling you
that the device proxy is running and the attached hardwareis
responding. Click OK.

7. The Step 4 dialog appears again. Click Next.
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8. InStep 5, click Test to test your connection. If the connectionis
established, the following message appears:

“Device proxy (<Instrument Name>) is running and the
attached hardware is responding.”

If the connection is not established the following message
appears:

“Device proxy (<Instrument Name>) is running but the
attached hardware is not responding. Response string is: ().”

If you get the above message, check the following items:
m  The cable connection between your instrument and PC
® You are connected to an available COM port on the PC

®  Theinstrument power is on, and that you are using the correct
cable. Refer to System Requirements on page 1-3 for alist of
system and equipment requirements.

Use the Back button to check your settings and reconfigure the
connection.

|| 11 Ifthereare no listings, there are no RS-232 connections
available. You should recheck your instrument-to-PC communication
cable and make sure the instrument power is on. You should also
make sure no other applications are using the RS-232 connection.

F inally, refer to sectiofiRS-232, which starts on page 7-1, for more
RS-232 information.

When you establish agood connection, click Next.

9. Click Finishin Step 6 to add thisinstrument and connection to
theIMSlist.
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Add Instrument: GPIB connected

Once you have connected the new instrument to the PC using the
appropriate GPIB cable, follow the steps below to use the I nstrument
Manager Service (IMS) to set up communications between the
instrument and the PC.

1
2.

Power on the instrument.

Check the GPIB address of your instrument; each instrument
connected to the GPIB bus must be set to a unique address. Refer
to the user manual for your instrument for information about how
to check and set that instrument’s GPIB address.

Open the IMS application, and click the Add toolbar button or
select Edit | Add Instrument...

When Step 1 of the Instrument Connect wizard appears, select
your instrument from the list, and click Next.

Step 2 lists al available GPIB connections between your PC and
your instrument. Select the desired connection, and click Next.

11 . If thereare no listings, there are no GPIB connections

available. You should recheck your instrument-to-PC communication
cable and make sure the instrument power is on. You should also
make sure no other applications are using the GPIB connection.
Refer to page 8-1 for more GPIB troubleshooting help.

6.

Step 3 alows you to enter an alias for your instrument. Thiswill
be the name that appearsinthe IMS Aliaslist and in the
WaveStar Software instrument explorer view. If you do not enter
aname, the product family nameis used by default. Enter an
aliasor leave the field blank, and click Next.

In Step 4, click Configure to reconfigure your connection settings
or Next to use the current GPIB settings. If you click Configure,
adialog appears showing the following settings:

Terminator. Terminator is the character added to the end of each
command or query to indicate the end of the command or query.
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Timeout. Timeout is the length of time the application will try to
communicate with the instrument before aborting the commu-
nication. The default setting is None, which each instrument
interprets differently.

Restore Factory Settings. Restores the GPIB settings originally
shipped with the selected instrument.

Restore Default Settings. Restores the predefined default
settings for the selected instrument.

If you want to make your new selections the default settings for
GPIB connections, click the Update GPIB settings button.

When you are finished configuring the settings, click Test New
Settings. If the settings are accepted, a dialog appearstelling you
that the device proxy is running and the attached hardwareis
responding. Click OK.

8. The Step 4 dialog appears again. Click Next.

9. InStep 5, click Test to test your connection. If the connectioniis
established, the following message appears:

“Device proxy (<Instrument Name>) isrunning and the
attached hardware is responding.”

If the connection is not established, the following message
appears.

“Device proxy (<Instrument Name>) is running but the
attached hardware is not responding. Response string is: ().”

If you get the above message, check the cable connection
between your instrument and PC, make sure that the instrument
power ison, and make sure that you are using the correct cable
and interface card. Refer to System Requirements on page 1-3 for
alist of system and equipment requirements. Use the Back button
to check your settings and reconfigure the connection. When you
establish a good connection, click Next.

10. Click Finishin Step 6 to add this instrument and connection to
the IMSlist.
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Add Instrument: AD007 or TDS3EM Connected

2-10

Refer to your AD007 GPIB-LAN Adapter User Manual to configure
the ADOO7 Adapter for your network installation. Refer to the
TDS3000 Series Programmer Manual for connecting the TDS3000
Series oscilloscope to a 10BaseT Ethernet LAN using the TDS3EM
Ethernet Communications Module.

Once you have connected the new instrument to the your 10BaseT
LAN using the appropriate RJ}-45 UTP cable, do the following steps
to use the TekVisa Configuration Utility to enable the IMSto locate
the instrument:

1. Select Start > Programs > TekVisa > Visa Configuration to run
the TekVisa configuration program. The program will take afew
moments to locate current resources.

2. Select the Add button in the Remote Hosts field to open the Add
Remote Host dialog box.

3. Enter the IP address of your instrument. For example,
128.23.304.45. Do not enter or change the values in the other
fields.

4. Select the OK button. The configuration program closes the Add
Remote Host dialog box and searchesthe LAN for the specified
address.

5. The configuration program updates the TekVisa Configuration
dialog box with the Visaresource for the newly—added instru-
ment. You use the resource name when you add the instrument to
the IMS list. Note that the Visa Configuration program and IMS
both label Ethernet resources as GPIBx::x::xxX; thisis OK.

6. If the Visa Configuration program does not |ocate your
instrument, check the following:

m  Theinstrument has been assigned an | P address.
®  Theinstrument |P addressisloaded into the instrument.
m  Theinstrument is powered on and connected to the LAN.

If none of the above fix the problem, work with your network
administrator to resolve the problem.
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7.

Follow the stepsin Add Instrument: GPIB Connected on
page 2-8 to use the Instrument Manager Service (IMS) to set up
communi cations between the instrument and the PC.

Add Instrument: Infrared (IR) to RS-232 Connected

Once you have connected the new instrument to the PC using the
appropriate cable, follow the steps below to use the Instrument
Manager Service (IMS) to set up communications between the
instrument and the PC.

1
2.

Power on your instrument.

Open the IM S application and click the Add button in the toolbar
or select Edit | Add Instrument...

When Step 1 of the Instrument Connect wizard appears, select
your instrument from the list and click Next.

Step 2 lists all the available RS-232 connections between your
PC and your instrument. Select the desired connection, and click
Next.

I'1 . If thereare no listings, there are no RS-232 connections

available. You should recheck your instrument-to-PC communication
cable and make sure the instrument power is on. You should also
make sure no other applications are using the RS-232 connection.

5.

Step 3 alows you to enter an alias for your instrument. Thiswill
be the name that appearsinthe IMS Aliaslist and in the
WaveStar Software instrument explorer view. If you do not enter
aname, the product family nameis used by default. Enter an
dias or leave thefield blank, and click Next.

In Step 4, click Next.

7. InStep 5, click Test to test your connection. If the connection is

established, the following message appears:

“Device proxy (<Instrument Name>) isrunning and the
attached hardware is responding.”
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If the connection is not established the following message
appears:

“Device proxy (<Instrument Name>) is running but the
attached hardware is not responding. Response string is: ().”

If you get the above message, check the cable connection
between your instrument and PC, make sure the instrument
power is on, and make sure you are using the correct IR to
RS-232 cable. Refer to System Requirements on page 1-3 for a
list of system and equipment requirements. Use the Back button
to check your settings and reconfigure the connection. When you
establish a good connection, click Next.

Click Finish in Step 6 to add this instrument and connection to
the IMSlist.

Remove an Instrument

Follow the steps below to remove an instrument from the IMS
application:

1
2.
3.

Open the IMS application.
Inthe Aliaslist, select the instrument you wish to remove.

Click the delete button in the tool bar or select Edit | Delete
Instrument.

Switching an Instrument Online or Offline

You can have more than one instrument listed in the IMS with the
same connection (see the Main Screen illustration on page 2-1).
However, only one of these instruments can be online at any given
time.

2-12

To switch an instrument online or offline, follow these steps:

1.

Select the instrument you want to switch online or offline in the
IMS main screen.
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2. Select Switch Instrument from the Edit menu in the IMS
application. One of the following dialogs will appear:

m If the connection is currently in use with another instrument,
adialog will appear asking you to verify that you want to
switch that instrument offline before switching the selected
instrument online.

m |f the connection for the selected instrument isnot in use, a
dialog will appear asking you to verify that you want to
switch the selected instrument online.

' | 11 . You can also use the toolbar to switch an instrument online or
offline. Refer to item 4 in the toolbar shown on page 2—4.

Shutting Down Service

The Instrument Server continues to occupy a COM port, even when
the IMS application is closed. To release the COM port, select
Shutdown Service from the Control menu before you close the IMS
application. Select Auto Shutdown from the Control menu to shut
down both the Instrument Server and the IM S application when you
exit the application.

Display and Print the IMS Activity Log

The IMS Activity Log shows the time, date, and description of all
communications between WaveStar Software and the instrument.

Display the Activity Log
Follow the steps below to display the IMS activity log:
1. OpenthelMS application.

2. Click the View Log button in the IMS toolbar. When the activity
log appears, you can select the following elements:
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m Local service activity. Logs communication between the
instrument and WaveStar Software.

m Internal program logic. Logs WaveStar Software operations.
m  Refresh button. Updates the activity log.
3. Click OK to dismissthe activity log.

Print the Activity Log

1. From the activity log, click Print; use the print dialog to print the
log.

2. From the IMSwindow, click Print in the toolbar or select Print |
Activity Log.
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Set Instrument Permissions

1. Openthe IMS application and select the instrument whose
permissions you wish to change.

2. Click the Properties button in the toolbar or select Edit |
Instrument Properties to display the Instrument Properties dialog
box.

3. Click thefollowing itemsto toggle the permissions on or off:
® Read Only
®m  Read/Write
m Visible
m Activity Logging

4. Click OK to apply your selections; press Cancel to discard them.
Both buttons dismiss the Instrument Properties dialog box.
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Operating Basics

This section outlines WaveStar Software features common to
WaveStar for Oscilloscopes and WaveStar Reader.

Main Screen Overview

The WaveStar window consists of a menu bar, atoolbar, and two
panes: the Explorer View and the Data Sheet Pane. The following
illustration label's each area of the WaveStar window.
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Menu Bar

The menu bar contains all commands available in WaveStar. You
access the menu bar commands using standard Window menu
processes. The menu bar is described in more detail on page 3-4.

Toolbar

The toolbar contains shortcuts to the most commonly-used WaveStar
commands. The toolbar is described in more detail on page 3-10.

Explorer View

The Explorer view lists all available instruments and their data,
settings, and controls, in a Windows Explorer-like tree diagram. You
copy and/or link data from an instrument in the Explorer view to a
data sheet in the Data Sheet pane. The Explorer view is described in
more detail on page 3-12.

|17 F . WaveStar Reader does not have the Explorer view.

Data Sheet Pane

The Data Sheet pane contains data sheets that provide an assortment
of waysto display instrument data. In the data sheet pane, you can
do the following tasks:

m  Create data sheets for displaying waveforms graphically, such as
strip recordings, as tables, as statistics, or as measurements.

m  Transfer datato and display it in the data sheets, using Windows-
standard drag and drop operations.

®  Document and analyze data, dragging and dropping it from data
sheets to Microsoft Office applications.

m  Display waveforms from one channel or from many in the same
data sheet or inindividual data sheets.

®m  Display the same waveform data graphically, as atable, or both
ways at the same time.
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m  Compare waveformsin various views simultaneously, in one or
more data sheets or in asingle document (if you drag datafrom a
data sheet into an M'S Word document or Excel spreadsheet).

®m  Print amonochrome or color hardcopy of your data (depending
on printer abilities).

There are four types of data sheets:

1. Waveform data sheets display instrument waveforms. These data
sheets let you view, record, or analyze waveform data. Available
waveform data sheetsare YT, XY, and Power Harmonics.

2. Scalar data sheets display instrument scalar data, such as
measurements and waveform sample points. Available Scalar
data sheets are Datal ogM easurement, Datal ogTabular, Scalar-
Viewer, StripChart, WaveformM easurement, and WaveformTabu-
lar.

3. The Notes data sheet displays graphical copies of waveform or
tabular data, instrument screen copies, instrument settings, and
notes that you add to the sheet.

4. The Instrument Explorer data sheet displays the contents of
instrument hard and floppy drivesin an Explorer-like window.

All data sheets in adata sheet pane are part of the current workbook
(.wk file extension). The workbook allows you to organize and save
your data sheets as a single collection. You can also save individual
sheets asfiles (.sht file extension) and add saved sheets to the current
workbook.

All of these data sheets are described in detail in Section 4,
Data Sheet Overview.
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The WaveStar Menu Bar

The menu bar contains menus and associated submenus that give you
accessto al WaveStar command functions. The menu bar is
dynamic; the menus shown, along with their contents, change
depending on which data sheet is active. The following table briefly
describes all possible contents of each menu.

File

New Datasheet...

Open...

Close Datasheet

Close Workbook

Save Datasheet
As...

Save Workbook
Save Workbook

As...
Start Workbook...

Stop Workbook...

ralagihaiizalaa
hi1alt hilaa hi a
Faldgihatizan
laa h fi

B hg@ah:fih

i

shematahiaa
e a
falagihatiahs
aahiiaifigafa
tha hagg h fia: | hag h

af hlaa h: afai 1 ha h

ta

ahuiingaf
a

raldgihaiiah
nlatfipafia

falaaaqfigafh
i Yia:hhaahi
aqiiaal hisaxifh
taalitiga

taaaqyfigafih
nYaihhaah

tagigaal hiatt
ikga
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File

Auto Versioning

Rename
Datasheet...

Import...

Export
Datasheet p

Print Setup...

Print Preview
Datasheet

Print Datasheet...

Print Preview
Workbook

Print Workbook...

Print Banner...

Recent File List

Exit

Aalal ai la a t fras
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tiat ha hagg h a:  hag
h fiai f haa hi a haa h
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Edit
Undo Cthalaaa al
Redo & h alaia @ a

Cut thgaa e fan b
a

Copy Ehiziaahiha b
a

Paste B hba fant h
aa h

Delete Eh#fal fir hiaa

i

Unlink I h# @a hi@a fii
i Haaatiigh

franldhi)ig
ifih laah: | 1fh i
Tai

Relink whiiaahiaal

Select All faafiiaalhiaa
e

New Annotation faldgihatiaih
#Y XYiihalaah Y a

Edit Annotation

1 I )i
Hirhaaiihi
lag

Clipboard tlaa fia haatah
Formats... la Fata taal
lail #iAlB Bal
thliFal F athattaf
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Edit
Swap XY fa hviga = aige 1 he XY
tf b XY laa hi
Find... ralagiiahhihf
aifirig
Replace... faldgiiahhihf
aifitig alfath ah
ifilig
Copy Voltage thiiag iaf fih
Waveform ar laa h
Copy Current hoaffih
Waveform araa h
Copy Power shoaalpaf fih
Waveform bianaa hi
View
Toolbar 1hiadatarff
Status Bar I1hada aaiff
Explorer View Fihisnff

Datasheet Toolbar

Mask Editing
Toolbar

Datasheet Status

"thd@ah:faff

Irhoaligaff

lthidaahiaalff

Bar
Refresh Datasheet | |aiaiaalh
aa hi
Refresh Workbook | jaialiiiaaldiaa
he f hi
Properties... ralagiaaief
h # aa hi
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View
Show Links... hikasai th hi 2 laa
e
Centered Fhgaith XYY h
(XY &YT only) ol hiraiiy aaa b

higatilag ha h:laa hin

Transfer Full Grati-  §h#gathiigiag a
cule (XY &YTonly) imihaaha
Bf 0 f hivar e
afa r ji h gat aa fa
Ihiaa hin

Masks (YT sheet only)
New Mask aarafiafs
fai Yia hiaiige alhe
i hial laaz
New Segment iai aialiaga aiigi | h

frfaiga Yia
hevhigeainatha |
a

Duplicate Segment

Add Point

Delete Point

Delete Segment

Delete Mask

FaagifihY hY
ankla

Change Size hagira iz f aigiig ofi
a
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Masks (YT sheet only)
Set Units

Tabular View

Format (Notes sheet only)

Fonts... & fifas ariz:e
agiihkh

Color... ghfioehag
het he

Alignment fhfiraatags
haaz ¢ hiaig:ih
i

Window

Cascade laitiaa hi1alaga fa
agfihefefhaa
h: @

Tile izzaahi1hiaa hiart ha
dhataiia

New Window raymiaah

Arrange Icons

hih: @

111zilaahinag h
1 fhlaa

Help
Contents and Index lfahaifzaifh
thi
What's This fa lha U hhiara
thoetahid
jgraifihhiahi
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Help

\WaveStar fanhaialaia
Introduction i fian

WaveStar Overview ia hilaia @ hit

Technical Support  hifia atraig ' o f
thia hy

About WaveStar... hi lada # fiau

The WaveStar Toolbar

The following figure and table describe the function of each toolbar
button.

M E =R EE R
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3| 3|2 raled

10 11 12 13 14 15 16 17

Item | Button name Description
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ltem | Button name

Description

a
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The Explorer View

The Explorer view graphically listsall connected instruments and
their associated parameters. There are three Explorer view categories
for each oscilloscope; Data, Setup, and Functions. The following
table describes these categories for atypical oscilloscope. However,
the actual instrument category contents depend on the connected-
instrument capabilities.

Data wlaaniiilaath

Display Jmelkaah

it atay fiia
Waveforms 1 afi th a hat al

fah afiirriiiaa h:
Masks #alaalyiiaa

h:YiaaiayY hi

hiial

Measurements

Settings
a a f é r‘x" fiifi1lag! =i f
i fa

System i frac e g a1
lath

3-12 WaveStar Software User Manual



Operating Basics

Setup mrra

Screen Copy irraazfihlaa ia
1al

Display tlaaazth a fia XYY
ag#iagiita

Acquire faqiaa:th atiar
aag |ar aag @ aqt |
1ff aii

Vertical i ha: ariah iafi fa
aa: th alath ig &
pdal

Horizontal thzatla@aih aa
alarigariigh a

Trigger fraiggaazih at
hiffriggrai

Masks fasgaaiaa
latja/fal tlaas alil

Measurements

Functions

WaveStar Software User Manua 3-13



Operating Basics

Using The Explorer View

To display the contents of an Explorer view subtree, click on the plus
icon next to an item you want to explore. Continue clicking on plus
iconsto open further subtrees. To close a subtree, click on the minus
icon next to the subtree. The lowest-level subtrees generally
represent the data or scope control that you can copy, link, or

execute.
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Copying Data from the Explorer View

Copying data results in a static snapshot of the data. The data does
not update in the application as it updates on the instrument. You can
manually refresh the data sheet by selecting the Refresh Datasheet

command in the View menu.

To copy awaveform or ascalar value into a data sheet, do these

steps:

1. Left click on the data object in the Explorer view, and hold down
the mouse button. Refer to [ in the following illustration.

2. Dragthe data object into the data sheet and rel ease the mouse

button. Refer to 1 in theillustration.
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3-16

Linking Data from the Explorer View

Linking data results in dynamic data that updates in the application
asit updates on the instrument. A GPIB interface allows for faster
WaveStar data sheet updates than does the RS-232 interface: RS-232
datatransfer rates are much slower than GPIB.

There are two methods of linking data to a data sheet or toolbar
button.

Linking Method 1.

1. Right click on the selected data object in the Explorer view, and
hold down the mouse button. Refer to L1 in the following
illustration.

2. Dragthe data object to target into the data sheet and release the
mouse button. Refer to [1.

3. Click Link in the shortcut menu that pops up. Refer to [1.

ol

T 11 LT L P P Pl = - R AL

L)
T w|@fm o] m|m]am
3 gri 18
‘Il:--un—. pa o
[ FE
[
L1 e
L

S Aoy e 17

WaveStar Software User Manual



Operating Basics

Linking Method 2.

1. Pressand hold the Ctrl+Shift keys. Refer to [ in the following
illustration.

2. Left click on the data object in the Explorer view, and hold down
the mouse button. Refer to [J.

3. Dragthe data object to the target. Rel ease the mouse button and
the Ctrl+Shift keys. Refer to [.
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Explorer View Links, Selections, and Properties

The dataand command icons a so | et you access further settings and
information by using a popup menu. Right-click on anicon to

display the menu.
@ Daplay ¥
W e Links .
S Pt Gelechions b
akz Sipis
Propertes. .

L amc gt

m  Show Links opens adialog box that lists the data sheets that are
linked to this data item.

m  Selectionslets you select from apop-up list of possible values.
Selecting a value sets the instrument to use that value.

®m  Properties opens adialog box with asinglefield. Thefield lets
you enter parameter values directly. Thisfield generally
duplicates the current value of the Selections menu.

®m  Execute causes WaveStar to execute the selected Explorer view
command.
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The WaveStar Reader

The WaveStar Reader lets you share data sheets and workbooks with
other users who do not have WaveStar for Oscilloscopes. Each user
must install the WaveStar Reader in order to open and work with
data sheets or workbooks.

You can install the WaveStar Reader from the WaveStar Software for
Oscilloscopes CD, or by downloading WaveStar Reader from the
Tektronix website (www.tektronix.com).

The WaveStar Reader operates exactly the same as WaveStar, with
the following caveats:

Non-available commands are greyed out.

Thereisno Explorer view in WaveStar Reader, as you cannot
connect or link to an instrument.

You cannot create new data sheets in WaveStar Reader

You can open existing data sheet and workbooks, add comments
or manipulate data, and save existing data sheets or workbooks to
the same file name or to new file names.

You can save data sheets that were part of aworkbook to
individual files. You can also save individual data sheetsinto a
new workbook file.

Data sheets that were linked in WaveStar for Oscilloscopes will
not relink to the instrument. Linked data sheets show their
last-acquired data.
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Data Sheet Overview

This section of the manual describes each type of data sheet, how
and when to use them, and explains behavior common to all data
shests.

Data Sheet Pane

The Data Sheet pane (refer to illustration on page 3-1) represents the
WaveStar workbook; the data pane is an open WaveStar workbook
that contains all data sheets that are part of the workbook file. You
can save individual data sheets without saving the workbook, or save
the workbook, which saves all data sheets within it.

Dragging a new workbook from Windows Explorer into the data
pane closes the currently open workbook and opens the workbook
you dropped onto the data pane. You are prompted to save the
currently open workbook file before it closes.

Dragging a data sheet to the data pane adds it to the open workbook.

Common Sheet Functions

All data sheets share some common characteristics. Data sheets
receive your data, waveforms, screen captures, and text, and then
display it according to the type of data sheet receiving the data. Data
sheets are used to:

m  Receive dataand update it if that datais linked to its source.
m  Store datawhen saved asindividual sheets or workbooks.

®  Source and receive data from other data sheets.
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Creating, Opening, Saving, and Closing Data Sheets

m  To create anew sheet in the open workbook, select File | New
and choose a sheet type.

®  To open an existing data sheet into a workbook, drag and drop a
*_sht file from the Windows Explorer into the data sheet pane.
(Or open it from the File menu or toolbar.)

m  To save adatashest, click onitstitle bar in the data sheet pane,

and then click the |E| button in the toolbar. You can also save a
data sheet by selecting File | Save Data Sheet.

m  To close adata sheet, select File | Close Datashest.

Start/Stop Data Acquisition

All data sheets contain Start and Stop acquisition tool bar buttons.
The Start button (triangle) starts data acquisition of al linked signal
and measurement sources to the selected data sheet. The Stop button
(square) stops data acquisition to the selected sheet.

>

m  The Start and Stop acquisition buttons do not update copied or
unlinked signal or measurement data.

® |f you stop a measurement that islinked to a datalog or strip
chart sheet, and then start the same measurement, WaveStar
displays amessage box stating that it will discard previously-re-
corded measurements if you start recording again. You can select
to start data acquisition again, or cancel start. If you need to
continue recording data for the stopped measurement, just open a
new data sheet and link the data to the new sheet.
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Zooming

The YT, XY, and Strip Chart data sheet tool bars contain controls for
zooming the contents of the data sheet window. Zoom Full Screen
and Drag Zoom buttons are not available in the Strip Chart data
sheet.

[sox | &|Q|z|=|

®  The percent zoom field displays the current data sheet magnifica-
tion setting, where 100% is the system-default zoom value. You
can also enter numeric valuesinto thisfield by moving the cursor
into the field, clicking the right mouse button, and typing in a
new value.

Clicking on the drop-down menu arrow displaysalist of
magnification values from which you can select.

®  The Zoom In button (magnifying glass with a plus symbol)
zooms into the data sheet.

®  The Zoom Out button (magnifying glass with a minus symbol)
zooms out from the data sheet.

m  The Zoom Full Screen button isthe Z with the 4-way arrow. This
button fits the graticule to the current data sheet window size,
alowing you to view the entire graticule.

m  The Drag Zoom button is the Z enclosed in a box. This button
lets you select a specific sheet areato enlarge. To use, select the
Drag Zoom button, then, in the graticule, click and drag the
mouse to draw a box around the part of the waveform you want
to enlarge.
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Sizing, Tiling and Cascading Windows

m  To scroll data or size the data sheet, use normal windows
procedures.

m  To auto arrange or otherwise manipulate windows or icons, select
the appropriate menu items in the WaveStar Window menu.

Previewing and Printing

m  To set up and preview or print data sheets, select the data sheet,
and then select File | Print. You can also print al the data sheets
that are open by selecting File | Print Workbook, and then
selecting the data sheets you want printed in the Print Workbook
dialog.

m  To print the full record length of all waveformsinthe YT data
sheet, select the data sheet and choose Print Banner... in the
WaveStar File menu. The Print Banner option is useful when
your YT data sheet contains waveforms that are longer than the
width of the graticule.

Copy and Linking

You can either copy or link waveform and scalar data onto a data
sheet. Copying takes a one-time snapshot of the waveform or scalar
data and places that data on a data sheet. Linking samplesthe
waveform or scalar data on aregular bases, constantly updating the
data sheet with the latest data.

®m  To copy awaveform or ascalar value into a data sheet, left click
the data object in the Explorer view and drag it into the data
sheet.

®  Tolink, right click the data object and drag it to the target. When
you release it, choose Link from the shortcut menu that pops up.
For more detailed information, refer to page 3-15.

4-4 WaveStar Software User Manual



Data Sheet Overview

Copying into Microsoft Office Applications

You can copy (but not link) awaveform from a data sheet into a
Microsoft Word document or Excel spreadsheet by left clicking the
data object and dragging it into an Microsoft Office application.

To copy numerical data (text) to the Windows clipboard, select
simple text or rich text in the Clipboard Formats dialog (in the Edit
menu). If you would rather copy a bit-mapped image of the data
sheet, uncheck both simple and rich text in that dialog. Then click
any measurement value and drag it to the Windows application to
which you want to copy the image.

Setting Properties

Property page settings determine the appearance and function of
each data sheet in the open workbook.

m  To access the Property page for a data sheet, click in itstitle bar
to select it, and then choose Properties from the View menu.

You can also access Property Pages by right clicking in an active
data sheet and selecting properties from the displayed submenu.
All right-click menus for data sheets contain a Properties option,
which provides access to individual property pages.

®  To navigate to individual tabbed sheets (if the property page has
multiple tabs), left click on the tab to bring it into the foreground
as needed. Click OK when you are finished entering property
settings to save the property settings, and close the dialog.

Shortcut Menu

Right click in the data sheet data area to display a pop-up menu for
performing the following tasks:

®m  Save, close, or print the data sheet.

m  Display the property sheet for this data sheet.

m  Show the data source links to the selected data sheet.
m  Accessthe online help for the selected data sheet.
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Data Sheets and Compatible Data Types

WaveStar data sheets can handle two types of data: waveforms, such
as those displayed from an oscilloscope channel, and scalar values,
such asavalts per division or awaveform measurement.

Each sheet can accept one or more data types and will display data
differently depending on the data sheet format and source data type.

Data Compatibility Between Data Sheets

Observe the following caveats when copying or linking data between
data sheet:

YT and XY data sheets can only accept datafrom YT, XY,
WaveformM easurement, or WaveformTabular data sheets (you
must drag a complete column of data from the WaveformMea-
surement or Waveform Tabular sheettoan YT or XY sheet).

The WaveformM easurement sheet can source either waveform
data (if you drag a complete column of data from the Waveform-
Measurement sheetto an YT or XY sheet) or scalar data (if you
drag asingle cell of datato ascalar sheet).

Scalar-val ue data sheets can only accept scalar data.

If you drag awaveform plot from the XY sheetto aY T sheet, the
plot is separated into its X and Y waveform components and
displayed as two individual waveforms.

If you drop data onto the XY sheet, the first two available
waveforms are copied to the X and Y components. If you drop
data onto a specific component box, the datais copied to that
specific box.
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Datalog Measurements Data Sheet

A Datalog Measurement sheet periodically captures and evaluates
the value of asingle scalar dataitem, such as awaveform measure-
ment. After evaluation, this data sheet updates its table with these

elements:

m  Current Value: The current time, value, and units of the variable.

® Maximum, Minimum: The maximum and minimum values, and

the time at which each occurred.

m  Average, Max-Min, Standard Deviation: Statistical values
calculated on the entire data stream. Time stamping is not

applicable.
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The Datalog Measurement sheet displays each new data value as the

current value and uses each new value to continually recompute

these measurements. It does not keep previous data val ues (compare

with the Datalog Tabular data sheet described on page 4-9).
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I/O Operations

You use drag and drop mouse operations to copy and link scalar
values, such as a TDS oscill oscope automatic measurement, from the
Explorer View to the datalogging measurement data sheet, dropping
the measurement anywhere in the data sheet table. Subsequent
copies or links to the same data sheet create separate charts (two
variables cannot be recorded in the same table).

You use drag and drop mouse operations to copy a data table from
data sheets to Microsoft Word or Excel. Two columns of scalar
values are transferred with measurement val ues appearing along
recording times.

You can get a screen image by dragging the entire sheet to Microsoft
Word. You can drag selected variablesto Excel or another datalog
measurement sheet. Refer to page 3—15 and page 4-4.

Copying vs. Linking

You should link your data (right click and drag it), rather than
copying because copying creates a value that doesn’'t update. This
data sheet monitors data, recording its variations.

Whenever the linked data changes, Explorer View notifies the sheet,
although measurements are not computed immediately. The sheet
stores the data until its display interval has elapsed, at which time
the new value is used to recompute the measurements. If no new
data has been received during the interval, the same valueis used.

Starting and Stopping

The recording can be started with one of three selections: Automatic,
Manual, and Time. The default is Automatic, with arecording time
of one second. Recording can be stopped with one of three
selections: Manual, Time, or Duration. The default is Manual. You
can set the recording methods from the Recording tab of the property
page. The minimum rate is 1 second.

Property Sheet

The property sheet can set table layout and how the recording occurs
(start and stops). Refer to Setting Properties on page 4-5. Refer to
the online help for detailed information on the datal og measurement
property dialog and each control field in the dialog.
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Datalog Tabular Data Sheet

A Datalog Tabular Sheet periodically captures and entersthe value
of asingle scalar dataitem, such as awaveform measurement, in a

table.
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The table displays each data point one row at atime as an entry
under the Value column. Time and Units columns record the time
stamp and the units for each data value at fixed timeintervals. As
each new value is recorded, any values outside the alarm limits are
drawn in the over- or under-limit colors, and a color-coded text label
isinserted in the Out Of Limit column so that you can quickly
identify out-of-limit measurements.

Starting and Stopping

The recording can be started with one of three selections: Automatic,
Manual, and Time. The default is Automatic, with adata refresh rate
of every two seconds. Recording can be stopped with one of three
selections: Manual, Time, Duration. The default is Manual. You can
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set the recording methods from the Recording tab of the property
page (refer to Setting Properties on page 4-5). The minimum rate
you can set is 1 second.

I/O Operations

You use drag and drop mouse operations to copy and link scalar
values, such as a TDS oscill oscope automatic measurement, from the
Explorer View to the datalogging-tabular data sheet, dropping the
measurement anywhere in the data sheet table. Subsequent copies or
links to the same data sheet create separate charts (two variables
cannot be recorded in the same table).

You use drag and drop mouse operations to copy a data table from
data sheets to Microsoft Word or Excel. Two columns of scalar
values are transferred with measurement val ues appearing along
recording times.

You can transfer the tabular data as a screen image by dragging the
entire sheet to Microsoft Word. You can also drag selected variables
to Excel or another Datalog Tabular sheet. Refer to page 3-15 and
Copy and Linking on page 4-4.

Copying vs. Linking

You should link your data (right click and drag it), rather than
copying because copying creates values that do not update. The
Datalog Tabular data sheet monitors data, recording its variations.

When you link ascalar value to atabular sheet, the source sends an
update whenever data changes, possibly at irregular intervals. The
data sheet collects all the data, but only enters the new row
containing adata point at the data-logging rate specified in the
data-sheet property sheet. If no new data has been received during a
data-logging interval, the data sheet retains the last value logged.

Property Sheet

The property sheet can set table layout, how recording occurs (start,
stops), and alarm limits on the recorded data. You can set these
properties from the Datalog Tabular property pages (refer to Setting
Properties on page 4-5). Refer to the online help for detailed
information on the datalogging tabular sheet property dialog box.
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Instrument Explorer Sheet

The Instrument Explorer data sheet lets you view and manipulate the
contents of instrument hard and floppy drivesin an Explorer-like
window. You can also:

Dofile utility tasks (copy, delete and paste files; create and
delete directories).

Drag and drop files from the instrument drive to a Windows
directory.

Drag and drop instrument setups within the same instrument or to
another instrument. Some instruments do not have accessible

system settings, and so will not display thisinfomation in the
sheet.

Drag and drop channel waveforms to reference waveform storage
within the same instrument or in another instrument.

Do remote screen hardcopy operations and save the hardcopy file
to aselected location.
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4-12

The Instrument Explorer sheet consists of atree view and afile view.
Thetree view (left side) shows drive directories and subdirectoriesin
ahierarchical tree layout, aswell asinstrument system files such as
saved setups and waveforms. The files view (right side) showsthe
contents of a selected tree view directory.

| | 71 . When you open the Instrument Explorer sheet, each
instrument actively connected to WaveStar is polled to obtain that
instrument’s drive and system infor mation. Therefore, the more
instruments connected to WaveStar, the longer it takes to open the
Instrument Explorer shest.

Accessing Drives and Directories

Instrument drives (hard disks or floppy drives) are represented by a
driveicon. To view the contents of a drive, select the + icon next to
that drive. The tree view displays any subdirectories that are within
the drive.

To view the fileswithin adrive, select the drive folder icon. Thefile
view displays all files and directories located within the sel ected
folder.

Manipulating Files

To quickly copy afileto another location on the same instrument, to
adrive on another instrument, or to a Windows directory, just drag
and drop the file to the desired destination.

' | 71, You cannot drag and drop folders.

WaveStar changes the cursor icon fromits default shape to a’not’
icon (Q) if a selected file or directory cannot be moved to the
current location.

You cannot copy a reference waveform onto a waveform channel or
math sourcefile.
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You can aso right-click on afile or folder to display a pop-up menu
that contains commands to copy, delete, and paste files, aswell as
directory commands that let you delete and create directories. The
pop-up menu is context-sensitive, only displaying or enabling the
commands that are available for the selected object.

The pop-up menu also contains a propertiesitem. Selecting
properties displays a message box that contains information such as
instrument name and the path to the selected object.

System Functions

Many instruments contain internal memory locations for instrument
setups, reference waveforms, and so on. WaveStar displays these
types of memory locations under the System icon in the tree view,
and handles them like files. System categoriesinclude Hardcopies,
Setups, and Waveforms.

Hardcopies. Hardcopies |ets you save the selected instrument’s screen
to aspecified file. The Hardcopiesfile view lists theimagefile
formats available to your instrument. This function isaremote
screen hard copy function. To save the instrument screen image to a
file, select the Hardcopies folder in the tree view, then drag and drop
the file format typeicon in the file view to the target instrument
drive or Windows directory.

Setups. Setups lists the available instrument setup locations. You use
these setup 'files' to save the current setup to a user setup, or load a
user setup into the current instrument. To copy a current setup to a
user setup, select the current setup in the file view and drag and drop
it onto the user setup icon in the same instrument. To copy a user
setup to a current setup, select the user setup icon and drag and drop
it onto the current setup icon of the same instrument.

Waveforms. Waveforms lists the instrument waveform storage
locations, as well as the waveform sources (channels, math
operations, and so on). To copy a channel or math waveform to
waveform storage, just drag and drop the waveform source onto a
reference (Ref1, Ref2 and so on) icon.
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Notes Sheet

The Notes data sheet |ets you enter and save textual notes and
graphical images that you want to record for the open workbook file.
Specifically, you can do the following:

4-14

Type textual notes.

Copy and paste notes and bitmapped images between the
clipboard and the notes sheet.

Drag and drop instrument screens from the Explorer View to the
notes sheet.

Drag and drop (or cut, copy, and paste, depending on application)
between the notes sheet and other Windows applications.

Save, recall, and edit instrument setup information in a Notes
sheet or other ASCI| text editor.

Right click in the data sheet area to pop-up a menu that lets you
save, close, or print your data sheet or access online help about
the data sheet.

Format the text font, color, and alignment using the tool bar
buttons. (If the toolbar buttons for the Notes Sheet are not
displayed, go to the View menu for the WaveStar application and
check Datasheet Toolbar.)

Use toolbar buttons and WaveStar menu commands to Save, Cut,
Copy, Paste, and Print notes sheet contents.

WaveStar Software User Manual



Data Sheet Overview

 HuolizaSheet| )
|rm-|- Haw Foman ;l |||'. :l Blfl“

L1

| | | |
Py prsments faken ot Jrues Valleyr plam

Bl al, 1999

TEM dewics 6

Euk 4

Supported Applications

Use your mouse to drag and drop text or bitmapped images between
the notes sheet and Windows applications such as Microsoft Office
applications and the Windows Notepad.

When copying an XY or YT graticule to another application, you
have the choice of copying the graticule asit is displayed on screen
(which may be apartial graticule) or copying the entire graticule.
Copying apartial graticuleisuseful if, for example, you want to
zoom in the display and copy a particular area of awaveform. To
always copy the entire graticule whether or not it is fully displayed,
select the View menu and check the Transfer Full Graticule menu
item.
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4-16

Saving and Recalling Instrument Settings

WaveStar lets you save, recall, and edit instrument settingsin the
Notes data sheet. You can save settings for the entire instrument or
specify acategory of settings such astrigger or horizontal. The
settings are stored as one long ASCI| string of instrument-specific
programming commands.

To save the current instrument settings, select Data | Settings in the
Explorer view. Then use the mouse to drag and drop the setting
information to save from the Explorer view to the Notes shest.

To recall settings to load into an instrument, open the Notes sheet
that contains the settings to load. Next, select the instrument setting
text with the mouse. Make sure you do not forget any text critical to
command syntax, such as colons or semicolons. Finally, drag and
drop the selected text onto the appropriate Data | Settingsicon in the
Explorer view.

If you are familiar with the programming commands for your
instrument, you can edit the commands in the Notes sheet to change
your instrument settings. Use the standard windows commands and
methods to enter, copy, cut, and paste text in the Notes sheet.
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Power Harmonics Data Sheet

The Power Harmonics data sheet displays power and harmonic
information based on signal voltage and current waveforms. You can
display the power and harmonic information in either table or
graphical bar chart format. The following figures show the same
power harmonics data in tabular and graphical format.

e
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Power Harmonics Conventions. The following conventions apply to the
Power Harmonics data sheet:

®  You need to provide both a voltage and current waveform.

® You can copy or link voltage and current information from an
instrument in the Explorer view or from another data sheet.

m  For optimum harmonics calculations, use four signal cycles.
Fewer cycles will result in less accurate cal culations, and more
cycles does not improve calculation accuracy. The status bar at
the bottom of the sheet displays an error message when fewer
than four cycles are used for calculations.
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Once both waveforms are copied or linked, the Power Harmonics
sheet cal culates the power waveform by multiplying the voltage and
current waveforms. You can copy or link the cal culated power
waveform to another data sheet. WaveStar recal culates and updates
power and harmonic information whenever the data changes (when
linked) or arefresh action occurs.

Power Harmonics Sheet Fields

The following text describes the purpose of each Power Harmonics
sheet field.

View. Selects between viewing datain graphical mode or tabular
mode.

Nmbr Harmonics. Selects the number of harmonics to use for
calculating harmonic information. The range of valuesisfrom
2to51.

Type (graph view mode). Selects which data type to display in the bar
graph area. Available types are voltage RM S, voltage % of
fundamental, voltage phase, current RM S, current % of fundamental,
and current phase.
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Waveform fields. L ocation where you drag source voltage and current
waveforms, and location of calculated power waveform that you can
drop onto another data sheet or instrument. The highlighted portions
of waveformsin the fields are the cycles used for cal cul ating power
harmonics information.

Trigger Adjustments. Aligns the voltage and current waveform trigger
points. The Power Harmonics sheet calculates power by aligning the
voltage and current waveforms trigger points. Because you can use
different instruments to measure voltage and current values, you may
need to align waveform trigger points. You can let WaveStar use the
waveform trigger points asis (automatic mode), or adjust the trigger
point for either or both the voltage or current waveforms (manual
mode).

Cycle Width. Sets the mimimum cycle width over which the sheet
calculates power harmonic information. You can let WaveStar
automatically determine the mimimum cycle width, or set thisfield
to manual and adjust the minimum cycle width to meet your
reguirements. Noisy signals may require you to manually select a
longer cycle width.

The Power Harmonics sheet shows which cycles are used for
calculations by highlighting the waveform cyclesin the Waveform
fields.
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Scalar-Viewer Data Sheet

If you want to view one or more scalar values, copy or link them
from the Explorer view to this data sheet. Such values display with
time stamp, data value, and data units.

When you want to compile a custom view of measurements (or any
set of scalar data) or download your TX-DMM stored memory
(WSTRM), use the Scalar-Viewer. For example, if you want to
continuously monitor measurements taken by different instruments,
connect those instruments to WaveStar and drag those measurements
from the Explorer View to acommon Scalar-Viewer sheet. Or drag
scalars from other data sheets to the Scalar-Viewer sheet.
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I/O Operations

You use drag-and-drop mouse operations to copy and link scalar
values, such as a TDS oscill oscope automatic measurement, from the
WaveStar Explorer View to the Scalar-Viewer sheet, dropping the
waveform anywhere in the data sheet table. Subsequent copiesto the
same Scalar-Viewer sheet create separate rowsin itstable.

Copy your data if you want to just get the current value; link it (right
click and drag it), if you want the data to update.

You use the same operations to copy and link scalar values from
Scalar-Viewer data sheets to other data sheets that accept scalar
values. Refer to page 3—15 and Copy and Linking on page 44.
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Supported Applications

You use drag-and-drop mouse operations to copy a Scalar-Viewer
table to data sheets or to Microsoft Word or Excel. Scalar values are
transferred with measurement values appearing alongside recording
times.

To copy abitmapped image of the data sheet instead of numerical
values, uncheck both simple and rich text in Clipboard Formats
dialog box, accessed from the Edit menu, before copying.

Property Sheet

The property sheet can set various attributes of the table layout. You
can set these attributes from the Scalar-Viewer properties page (refer
to Setting Properties on page 4-5). Refer to the online help for a
detailed description of the Scalar-Viewer data sheet property page
and each entry field in the property sheet.

StripChart Data Sheet

4-22

A StripChart data sheet plots the value of from 1 to 16 single scalar
dataitems, such as a waveform measurement, on ascrolling
horizontal graticule. Although you can monitor up to 16 valuesin a
StripChart data sheet, for practical reasons you will probably not
want to measure more than two or three variables per data sheet.

The StripChart data sheet contains two windows; the current data
window, and the history data window. The current data window
shows the current data for the last n time periods, where nis defined
by the acquisition sample rate. New data’ pushes' old datato the left
edge of the graticule, and data at the |eft edge of the current data
window is erased from the graticule. You can choose to have points
on the graph connected by lines or displayed aslevels (dots).
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The history data window displays all data points acquired from the
start of the current acquisition. To view the history window, move
the cursor onto the vertical window separator bar at the |eft of the
current data window, press and hold the |eft mouse button, and drag
the separator bar to the right. You can then use the scroll bar controls
to view entries in the entire history data window. By default, the
history data window is minimized when you first open a StripChart
data sheet.
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I/O Operations

You use drag and drop mouse operations to copy and link scalar
values, such as a TDS oscill oscope automatic measurement, from the
Explorer View to the StripChart data sheet, dropping the measure-
ment anywhere in the graticule area. Subsequent copies to the same
StripChart sheet create separate strip chart graticules within the
StripChart window (two measurements cannot be plotted on the
same StripChart graticule). You cannot drag waveformsfromaYT
or XY sheet to a StripChart sheet.

You use drag and drop mouse operations to copy a StripChart
recording to data sheets or Microsoft Word or Excel. Two columns
of scalar values are transferred with measurement val ues appearing
along recording times. Refer to page 3—15 and Copy and Linking on
page 4-4.

Copying vs. Linking

Strip charts monitor data, recording its variations. Because of this,
you should link your data rather than copying it, since copying
creates avalue that does not update. To link data, right click on the
data and hold down the mouse button; drag the data to the Strip chart
sheet. Then select Link from the shortcut menu that pops up.

When you link ascalar value to a Strip chart sheet, the data source
sends updated data whenever data changes, possibly at irregular
intervals. The data sheet collects al the data, but only plots adata
point at the plot rate specified in the strip-chart property sheet. If no
new data has been received during a data-logging interval, the data
sheet plots the last value logged.

Starting and Stopping

The recording can be started with one of three selections: Automatic,
Manual, and Time. The default is Automatic, with arecording
sample time of one second. Recording can be stopped with one of
three selections: Manual, Time, or Duration. The default is Manual .
You can set the recording methods from the Recording tab of the
property page (refer to Setting Properties on page 4-5). The
minimum data sample rate you can set in the properties pageis

1 second.
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| 71 If yourestart recording on a stopped sheet, all data in that
data sheet islost. To save data, open a new data sheet and link to the
same sources as the stopped sheet.

Property Sheet

The property sheet can set avariety of display characteristics, turn
on various types of measurement cursors, and more. You can set
these properties from the Strip Chart properties pages (refer to
Setting Properties on page 4-5). Refer to the online help for
detailed information on the StripChart property dialog and each
control field in the dialog.

Cursors

Cursors are used to measure the waveform plot. You can put cursors
on the strip-chart sheet using the Cursor Property Page. Cursor
readout values indicate the vertical or horizontal value at the cursor
location. Vertical cursor position values appear asdX and X.
Horizontal cursor position values appear asdY and Y.

Vertical and horizontal are the only permitted cursor types on the
Stripchart sheet.

Waveform Measurement Data Sheet

The waveform measurement data sheet displays atable of standard
waveform measurements. When you drag a waveform to this sheet,
the application automatically calculates and displays the measure-
ment values as shown below in the following figure.

Each waveform is presented as a column of measurements. Each
time a new waveform is dropped onto this sheet, a new column of
measurements is created immediately to the right of any existing
columns.

I/O Operations

You use drag and drop mouse operations to copy and link waveforms
(not scalar data) from the Explorer View to the waveform measure-
ment data sheet.
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You use the same operations to copy and link waveforms from this
data sheet to other data sheets. You can also copy or link asingle
measurement from this data sheet to any other sheet that accepts
scalar values. Refer to page 3-15 and Copy and Linking on

page 4-4.
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Supported Applications

You use drag and drop mouse operations to copy measurements from
this sheet to Microsoft Word or Excel. Specifically, you can do the
following:

m  Click asingle measurement and drag it to Microsoft Word or
Excel.

m  Shift click to select more than one measurement for dragging as a
group.

m Click inthetitle bar to select al of the measurements; shift click
to select additional columns as desired. After selecting the last
column, hold shift to drag all the columns to Word or Excel.

Property Sheet

Use this property sheet to control table layout characteristics and the
measurement method (refer to Setting Properties on page 4-5).
Refer to the online help for detailed information on the waveform
measurement property dialog and each control field in the dialog.

Gates

You can use gatesin YT and waveform tabular data sheets to define
a segment of awaveform for copying or linking to the waveform
measurement sheet. Such operations et you determine the part of the
waveform measured by using the gatesto isolate a portion of the
waveform.

Waveform Tabular Data Sheet

A Waveform Tabular Sheet creates atable of values for each
waveform that you copy or link toit. It periodically updates the
valuesif you link them from the data source.

The Waveform Tabular Sheet shows the waveform as sequential
valuesin atable column with each value accompanied by atime
value. Thetime value isthe time of the waveform sample relative to
the waveform record trigger.
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You can modify the waveform by editing the table cells, but you can
not change the length of the waveform by adding or deleting cells,
nor can you change the units.
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I/O Operations

You use drag and drop mouse operationsto copy and link wave-
forms, such as channel waveforms from a TDS oscill oscope, from
the Explorer View to the waveform-tabular data sheet, dropping the
waveform anywhere in the data sheet table. Subsequent copies or
links to the same data sheet create separate table charts (two
waveforms cannot be recorded in the same table). You must drag a
complete waveform (a column) to an XY or YT data sheet (or
another Waveform Tabular data sheet).
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Use drag and drop mouse operations to copy atable from a data
sheet to a Microsoft Office application. Two columns of scalar
values are transferred with measurement values appearing along
recording times.

You can transfer the tabular data as a screen image by dragging the
entire sheet to Microsoft Word. You can also drag selected variables
to Excel or another Datalog Tabular sheet. Refer to page 3-15 and
Copy and Linking on page 4-4.

Property Sheet

Use this property sheet to control table layout characteristics (refer to
Setting Properties on page 4-5). Refer to the online help for

detailed information on the waveform tabular property dialog and
each control field in the dialog.

Gates

Gates define the range over which measurements are computed when
waveform datais moved from this sheet to a Waveform Measure-
ment sheet. Set gate location by moving the gate icon to the desired
location. Gate location is represented by highlighting the correspond-
ing row of data.
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XY Data Sheet

The XY sheet displays waveformsin pairsas XY plots, with one
waveform plotted on the X (horizontal) axis against the other on the
Y (vertical) axis. The XY plot uses the same scale and position as
the oscill oscope channels from which the XY components are
obtained.

The XY sheet presentsthe XY plot asapair of X and Y component
boxes, which appear along the bottom of the graticule.
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I/O Operations

Using the mouse to copy and link waveforms from the Explorer
View tothe XY data sheet, you can do the following 1/O operations:

m Dragindividua channel waveforms from the Explorer View and
other data sheetsto the individual X or Y component boxes
(located just below the bottom graticule) that comprise each XY
waveform.
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®m  Drag two instrument waveforms simultaneously to an XY sheet
by dragging the instrument icon from the Explorer View and
dropping the icon anywhere on the XY graticule. Thefirst
waveform in the hierarchy is plotted as X, the second as .

m  Dragfrom each X and Y component individualy, to the Explorer
View or another data sheet. To restore the waveform as a saved
waveform for an instrument, display the instrument reference
memories, and drag the waveform to the memory that isto store
the waveform. You cannot undo this operation.

m Dragand drop X and Y componentsindividually or asan XY
waveform into Microsoft Office applications.

When copying an XY graticule to another application, you have the
choice of copying the graticule asit is displayed on screen (which
may be a partial graticule display) or copying the entire graticule.

Copying apartial graticuleis useful if, for example, you want to
zoom in the display and copy a particular area of awaveform. To
always copy the entire graticule, select the View menu and check the
Transfer Full Graticule menu item.

You can drop data onto either the XY sheet or to a specific
waveform component box. Data dropped onto the XY sheet usesthe
first two waveforms asthe X and Y components. Data dropped onto
a specific waveform box overwrites existing data. The XY plot is
drawn when both the X and Y component boxes arefilled in.

Property Sheet

The property sheet can set various display and measurement
characteristics. You can set these properties from the XY Properties
page (refer to Setting Properties on page 4-5). Refer to the online
help for detailed information on the XY sheet property dialog and
each control field in the dialog.

Cursors

Cursors are used to measure the waveform plot. You display cursors
using the Cursor tab on the Property Page. Cursor readout values
indicate the vertical or horizontal value at the cursor location.

Vertical cursor position values appear as dX and X. Horizontal cursor
position values appear asdY and Y.
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YT Data Sheet

4-32

The YT data sheet lets you capture and graphically view multiple
waveforms on a graticule with the same scale and position as on the
oscilloscope. You aso usethe YT sheet to copy and edit waveform
test masks. The YT sheet can display waveform and mask data
simultaneously, enabling you to create a mask to fit a particular
waveform.

Waveform Operations

The YT sheet displays one or more waveforms as a graphical view.
This sheet displays amplitude on the Y-axis and the sampling index
(for example, time) on the X-axis. The YT sheet displays waveforms
and a graticule at the same scale and position as they appear on the
oscilloscope screen. The number of waveforms that can be displayed
islimited only by available memory. Some of the features of this
sheet include cursor measurements, gates, zoom function, and
annotation.
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Copying Waveforms To and From an Instrument.

You use drag and drop mouse operations to copy and link waveforms
from the Explorer View to the YT data sheet, dropping the waveform
anywhere in the graticule area. You also use drag and drop mouse
operations to copy data from data sheets to other Microsoft Windows
applications. When copying a YT graticul e to another application,
you have the choice of copying the graticule asit is displayed on
screen (which may be apartial graticule) or copying the entire
graticule.

Copying apartial graticuleis useful if, for example, you want to
zoom in the display and copy a particular area of awaveform. To
always copy the entire graticule whether or not it is fully displayed,
select the View menu and check the Transfer Full Graticule menu
item.

To restore the waveform to a specific channel, expand the instrument
data channelsin Explorer View, and drag the waveform to the
desired channel. You cannot undo this operation. Refer to page 3-15
and Copy and Linking on page 4—4 for more information.

Changing the Waveform Scale. The Scale pulldown lists (located to the
left of the Waveform button) in the sheet toolbar et you change the
voltage or time scale of the selected waveform. To change a
waveform’s scale, select awaveform, then select the arrow button
adjacent to the scale value to change. Select anew scale value from
the pulldown list. The YT sheet redraws the selected waveform using
the new scale value.

Selecting the Waveform Color. The Waveform button in the sheet
toolbar lets you change the color of the selected waveform. To
change awaveform color, select awaveform, then select the
Waveform button. Select a new waveform color, then select OK.

Property Sheet. The property sheet can set various display and
measurement characteristics. You can set these properties from the
YT Properties page (refer to Setting Properties on page 4-5). Refer
to the online help for detailed information on the YT sheet property
dialog and each control field in the dialog.
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Cursors. Cursors are used to measure the waveform plot. You can put
cursors on the selected sheet using the Cursor tab on the Property
Page. Cursor readout values indicate the vertical or horizontal value
at the cursor location. Vertical cursor position values appear as dX
and X. Horizontal cursor position values appear asdY and V.

Gates. Gates define the range over which measurements are
computed when waveform datais moved from this sheet to a
waveform measurement sheet. Turn on gates by choosing vertical
cursorsin the Cursor Property dialog and checking the Gate with
Vertical Bar Cursors checkbox; then, set gate location by using the
mouse to move the cursors.

Print Banner

To print the full record length of all waveformsinthe YT data sheet,
select the data sheet and choose Print Banner... in the WaveStar File
menu. The Print Banner option is useful when your YT data sheet
contains waveforms that are longer than the width of the graticule.

Mask Editing

The YT sheet mask editing features allow you to create new test
masks for an instrument family by modifying existing masks or
defining mask parameters from scratch. The copied mask retains the
instrument settings that were part of the original mask.

To edit an existing mask, or create anew mask based on an existing
mask, simply drag and drop amask from the Explorer view onto the
YT sheet. WaveStar draws the mask on the graticule and shows
existing line vertexes (points) as small squares, as shown in the
following figure.

[ 11 . Ifamaskisvisible onyour YT sheet, and you copy or link the
YT sheet to another data sheet, the mask data is copied along with
the waveform data. To prevent this, clear the Show Mask checkbox in
the toolbar before copying or linking the YT sheet data to other
sheets.
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Mask Editing Conventions. The following conventions apply tothe YT
mask editing functions;

m  Copying anew mask onto a YT sheet with an existing mask
deletes the existing mask and replacesit with the new mask.

®  Thisdocumentation refers to each polygon in amask asa
segment, and a collection of segments as a mask. However, some
instrument documentation calls each segment a mask, aswell as
the collection of segments.

m  Each CSA-Series mask can contain a maximum of ten segments:
Each TDS-Series mask can contain a maximum of eight
segments.

m  Each mask segment can have a maximum of 50 points.

®m The YT sheet connects mask pointsin the same order that the
mask source instrument connects those points. As different
instruments use different algorithms to store and connect mask
segment paints, copying a mask from one instrument seriesto
another may change the mask point order, and therefore change
the mask segment shape.

m  To select amask point or segment, position the cursor on the
point or in the segment and double—click the left mouse button.
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Selecting Mask Color. The Mask button in the sheet toolbar |ets you
change the color of the mask outline. To change the mask outline
color, select the Mask button, select anew mask color, then select
OK. The new mask color is stored and automatically used for al new
YT sheets you open.

The mask color only affectsthe YT sheet mask color; the instrument
will useits default mask color when you copy the YT mask to an
instrument.

Show Mask. You use the Show Mask check box to toggle viewing of
the mask onthe YT shest.

Show Bounding Box. You use the bounding box mode to quickly resize
amask segment. Bounding box mode displays a box around each
segment that includes resizing points on the corners and sides of the
bounding box. When you select and drag aresizing point, the
bounding box redraws the mask segment proportionally to fill the
resized bounding box. You cannot move any individual segment
points while you are in bounding box mode.
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Moving Mask Segment Points. To select a segment point, position the
cursor on the point A selected point fills with the current mask color.
To move the point, press and hold the left mouse button and drag the
point to anew location.

You can use the Zoom control on the YT sheet toolbar to magnify
the image for performing critical point positioning. The point
position values are shown in the status bar at the bottom of the sheet.

| | 71 . Asstated in the mask edit conventions section, different
instruments use different algorithms to store and connect mask
points. In some instruments, moving a point past a diagonal
boundary causes that point to detach fromits current line and
reattach to a line on the other side of the boundary. Thisis normal
behavior for these instruments. The YT sheet duplicates this behavior
so that the mask segments you create on the YT sheet will look and
work correctly on the target instrument.

Adding and Deleting Mask Points. The Mask editor lets you add new
points to a segment halfway between the selected point and the next
point counterclockwise from the selected point. To add a point,
select the point, then press the right mouse button to display the
pop-up menu. Select Add Point. The YT sheet adds the new point to
the line segment.
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To delete a point, select a point, click the right mouse button, and
select Delete Point from the pop-up menu.

Adding, Duplicating, and Deleting Mask Segments. To add a new segment
to amask, select Mask > Add Segment from the WaveStar main
menu. WaveStar adds a small box segment to the upper-left corner of
the graticule, and assigns it the next consecutive mask segment
number. You can then edit this new segment by adding and moving
points to obtain the mask segment shape you need.

To duplicate a segment, position the cursor within the segment; the
cursor will change to afour-way arrow to indicate that you are
within a segment. Then right-click the mouse to display the pop-up
menu. Select Duplicate; WaveStar draws the duplicated segment
dlightly above and to the right of the selected segment.
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To delete a mask segment, position the cursor within the segment,
right-click the mouse, and select Delete Segment from the pop-up
menu. WaveStar del etes the selected mask segment. You can also
delete the entire mask by selecting Delete M ask from the pop-up
menul.

The Change Size... pop-up menu item opens adialog box that lets
you enter numeric parametersto increase or decrease the size of a
segment.

Mask Table Editing. Another way to move pointsis to use the mask
point table. The point table lists all pointsin a segment with their
corresponding position. To display the point table, select a segment
and right-click the mouse button to display the segment pop-up
menu. Select Tabular View... ; WaveStar displays the Mask Tabular
View dialog box.
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To edit the values in the dialog box, position the cursor in the table
cell to edit, then left-click the mouse. Enter the new value for the
cell. Repeat for each cell to edit. The mask segment updates
immediately when you enter new valuesin the table.
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®m  To add anew point to the table, select arow and then press the
INSERT keyboard key. The table editor inserts a new blank row
above the selected row.

m  To add anew point to the end of the table, select the last row in
the table and then press the ENTER keyboard key.

m  To delete apoint from the table, select the point row to delete
and press the DELETE keyboard key.

m  To edit adifferent segment, select a new segment from the
Segment Identifier pulldown list.

®  When you are done editing the table cells, select the Close
button.

®m  To change the units used to display the point positions, select the
Units list to select between Amplitude/Time and Divisions. The
table values update to show the selected unit type.

Creating a New Mask. You can use WaveStar to create new masks
from scratch. To create anew mask, open anew Y T data sheet. Then
select Masks > New Mask. Next, select the target instrument family
for the mask from the Select Instrument dialog box. WaveStar draws
asquare segment in the center of the YT graticule. Finally, use the
mask edit functions to create the segments for your new mask.
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To set the mask parameters, open the Edit Mask Parameters dialog
box (Masks> Tabular View > Edit Parameters...). The number
and type of parameters displayed depends on the parameters
supported by the target oscilloscope. Refer to oscilloscope
documentation for a description of that instrument’s mask parame-
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Saving a Mask. WaveStar handlesa YT sheet with a mask just like any
other data sheet file; you can save the YT sheet as part of a
workbook, or you can savethe YT sheet to an individual file. You
can create amask library by creating a workbook that contains only
YT sheetswith mask data. You can also save mask data by exporting
ittoa.MSK format file. Refer to page 442 for information on how
to import and export .MSK files.

Copying a Mask to an Instrument. When you are ready to load your
mask on an instrument, position the cursor within the graticule but
outside of any mask segments. Press and hold the left mouse button,
and move the cursor to the appropriate icon in the Explorer view.
WaveStar loads the mask datainto the instrument.
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Importing/Exporting a Mask. WaveStar can import and export M SK
mask format files. To import aMSK file, select File> Import...,
select Mask Files Type, and navigate to the mask file to import.

WaveStar loads the mask datainto the active YT data sheet.

For your convenience, WaveStar comes with library of mask filesin
.MSK format. The mask library islocated in the WaveStar
installation directory, in adirectory called MaskLibrary. The mask
files are organized by instrument family and measurement type.

To export the mask in the active YT sheet to a.MSK file, select
File> Export Datasheet..., and then enter the file name and
destination directory.
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Procedures

This section outlines procedures for both WSTRO and WSTRM
WaveStar Software.

Display Waveforms in the YT Data Sheet
Follow the steps below to display waveformsinthe YT view.

1. Inthe Explorer View, click on the Data branch under the
instrument that will source the waveform to display the data
resources under it.

2. Double click on the Waveforms resource (or single click its+) to
display the waveform sources below it.

3. To copy, left click and drag the waveform resource (Channel,
Math, or Ref) tothe YT data. Rel ease the waveform in the data
sheet graticule areato drop the waveform on the data sheet.

4. Tolink rather than copy, right click and drag the waveform to the
YT data sheet. Release the mouse button, and select Link in the
shortcut menu that pops up.

5. Repeat this procedure to copy or link additional waveformsto the
data sheet as desired.

Tips
m  Drag the channel indicator (located left of the graticule) up and

down to vertically position the waveform. (You can also use the
keyboard arrows (1 and () to position the waveform.)

m Drag the waveform record view (located above the graticule) to
horizontally position the waveform in the graticule. (You can also
use the keyboard arrows (~ and - ) to position the waveform.)

m  Toremove the waveform just dropped into the window,
immediately select Undo Drop Waveformsin the Edit menu (the
undo function is not available for extremely large records).
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Display Two Waveforms in the XY Data Sheet
Follow the steps below to display waveformsin the XY view.

1.

In the Explorer View tree, click on the Data branch under the
instrument that will source one of the waveforms to display the
Data resources under that Data branch.

Double click on the Waveform resource (or single click its +) to
display the waveform sources below it.

To copy, left click and drag the waveform source (Channel, Math,
or Ref) onto the X tab. Release the waveform while holding it
over the X tab.

To link rather than copy, right click and drag the waveform to the
X tab. Release the mouse button, and select Link in the shortcut
menu that pops up.

Repeat this procedure to display a'Y source and copy or link it to
the Y tab. Be sureto release over the Y tab, not the X tab.

1. The X and Y tabs always appear below the graticule. If they

are not visible, expand or scroll the data sheet window.

Tips

If you drag and drop a data source icon that contains more than
two waveforms onto the XY graticule, the first waveform in the
list will be used for the X tab and the second available waveform
will be used for the Y tab.

Drag the indicator to the left of the graticule up and down (or use
thekeyboard 1 and | arrows) to vertically position the XY plot
to position the waveform.

Drag the indicator above the graticule to horizontally position the
XY plot.
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m  To swap the X waveform with the Y, select Swap XY from the
Edit menu.

m  Toremove awaveform just dropped into the window, immediate-
ly select Undo Drop Waveformsin the Edit menu.

Dynamically Position Waveforms

1. Inan XY or YT data sheet, |ocate the channel indicator of the
waveform to be positioned. Y T sheets have channel indicators on
the left border of the graticule; XY sheetshaveaY channel
indicator on the left border and an X channel indicator on the top
border of the graticule.

2. Click and drag any of the channel indicatorsto adjust positions as
desired up and down (and left and right for XY data sheets).

3. YT waveforms have awaveform record view above the graticule.
Click and drag the record view to position the selected waveform
horizontally in the graticule.

Zoom the YT, XY, or StripChart Data Sheets

In YT, XY, or StripChart data sheets, use the following methods for
zooming in or out.
To Zoom in Increments or by %

Click thefirst toolbar button from the |eft to zoom in; click the
second toolbar button to zoom out.

Select a percentage to zoom to from the drop-down list on the data
sheet toolbar. The display will zoom to a percent of the default full
size.

To Zoom to Full Screen (YT and XY sheets only)

Click the third toolbar button to zoom the data sheet display to best
fit the current size of the graticule to the data sheet window.
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To Zoom On a Waveform Feature (YT and XY sheets only)

Click the fourth toolbar button to begin to zoom in on awaveform
feature. Left click and drag to draw a zoom box around the feature to
be viewed. Release the left mouse button to complete the zooming.

Change the YT or XY Waveform Display (Properties)

To change the position and scale of awaveformina YT or XY data
sheet, first opena YT or XY data sheet, and drag waveform data
from the Explorer View into the data sheet.

To Position a Waveform

For datain both YT and XY data sheets, drag the channel indicator
(left of graticule) up and down to vertically position the waveform.

For datain an YT data sheet, drag the waveform record view (above
graticule) to horizontally position the selected waveform in the
graticule.

To Scale a Waveform

1. Select Properties from the View menu.

2. Select the Graticule tab in the Properties dialog and set the
number and size of the horizontal and vertical divisions.

3. Select the desired waveform tab in the Properties dialog; use the
pulldown lists to select the horizontal and vertical scale and
position settings of the waveform.

4. Click OK to apply the changes and close the Properties dial og.

To Change Waveform Color

To change the color of awaveform after the waveform has been
acquired, follow the steps bel ow.

1. Whileinthe XY or YT data sheet, select View | Properties.

2. When the Waveform Properties dialog window appears, select
the tab containing the name of the desired waveform, click the
color button, select a new color from the Color window, and click
OK to accept the color change and close the dialog.
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3. Click OK inthe Waveform Properties dial og window.

To Lock the Trigger Points or Horizontal Scales of YT Waveforms

1. Withthe YT data sheet selected, select Properties from the View
menu.

2. Select the Plot tab in the Properties dialog.

3. Select or deselect the check boxesto toggle locked trigger points
and horizontal scales.

4. Click OK to accept the changes and close the Properties dialog.

To Display the Trigger Point on YT Waveforms

1. Withthe YT data sheet selected, select Properties from the View
menu.

2. Select the Plot tab in the Properties dialog.

3. Select or deselect the Display Trigger Point checkbox to toggle
the trigger point display on the graticule.

4. Click OK to accept the changes and close the Properties dialog.

To Change the Graticule for XY and YT Data Sheets

1. With either an XY or YT sheet selected, select Properties from
the View menu.

2. Select the Graticule tab in the Properties dialog. In this dialog
you can set the following Graticule properties:

Graticule Type. Select from Full, Grid, Crosshairs, or Frame.
Horizontal Divisions. Set the number of horizontal divisions.
Vertical Divisions. Set the number of vertical divisions.

Size of Divisions. Set the size and dimensions of the horizontal
and vertical divisions.

Graticule Color. Set the graticule color.
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Background Color. Set the graticule background color.

Print black and white. Toggles the printing color of the data
sheet.

Set Default. Click Set Default to set the new settings as default.
3. Click OK to accept the changes and close the Properties dialog.

To Change the Plot Style of XY Waveforms

1. Withthe XY data sheet selected, select Properties from the View
menu.

2. Select the Plot tab in the Properties dialog.

3. Inthe Plot Type pulldown list, select either Dots or Vectors for
the plot type. Dots displays the waveform data points as
individual dots on the graticule. Vectors displays the waveform
data points as a connected line on the graticule.

4. Click OK to accept the changes and close the Properties dialog.

Creating a New Mask
1. Openanew YT data sheet.
2. Select New Mask from the Masks menu.

3. Select the target instrument family for the mask from the Select
Instrument dialog box.

4. Usethe mask edit functions to create and edit the segments for
your new mask.

5. Select Tabular View from the Masks menu.
6. Select the Edit Parameters... button.

7. Enter the mask parametersin the Edit Mask Parameters dialog
box.

8. Click OK to accept the mask parameters.
9. Savethe YT sheet.
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Measure Waveforms using the Waveform Measurement
Data Sheet

Drag and drop waveform data from YT, XY, or Waveform Tabular sheet
into Waveform Measurement sheet

1

OpenaYT, XY, or Waveform Tabular sheet with waveform data
init.

Select New from the File menu and select Waveform Measure-
ment Sheet from the New Sheet dialog.

Use the mouse to drag the waveform (from the XY or YT sheet)
or column of waveform data (from the waveform tabular sheet)
to the waveform measurement data sheet. The waveform
measurement data sheet will update with measurement val ues of
the waveform data you dragged to it.

Gate and drag and drop waveform data from YT sheet to Waveform
Measurement Sheet

1
2.

Open a YT sheet with waveform datain it.

Select New from the File menu, and select Waveform Measure-
ment Sheet from the New Sheet dialog.

With the YT sheet selected, select Properties from the View
menu. Select the Cursor tab and turn on the Vertical cursors.
Check the Gate with vertical bar cursors box; click OK to accept
the changes and close the Properties dial og.

To gate data, click and drag each cursor until they span the data
you want to transfer, and then drag the data to awaveform
measurement data sheet.
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Gate and drag/drop from Waveform Tabular Sheet

1
2.

Open awaveform tabular sheet with YT waveform datain it.

Unlike gatesin a YT data sheet, there are no cursorsto turn onin
awaveform tabular sheet; each waveform table has a column that
contains the Start and Stop gates and a trigger point indicator.

To gate data, click and drag each gate until they span the data
you want to transfer, and then drag the data to awaveform
measurement data sheet.

Measure StripChart Plots using Cursors

1.

Select New in the File menu, and select StripChart from the New
Sheet dialog to open a StripChart data sheet.

With the StripChart sheet selected, select Properties from the
View menu.

Select the Cursors tab in the Properties dialog, and select a cursor
type from the pulldown list. Click OK to apply the new settings
and close the dialog.

Use the mouse to set the cursor positions in the StripChart data
sheet.

Set Up Instrument (Data Source)

1.

Make sure the GPIB or RS-232 connection from the PC to the
instrument is established.

With a GPIB or RS-232 connection between the PC and the
instrument established, instrument resources, including most
control settings, automatically appear in the Explorer view.

In the Explorer view, click on the Setup branch under the
instrument to be adjusted to expand the instrument setup
properties under it.

Click the control to be adjusted, and then right click to pop up its
shortcut menu.
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5. If the shortcut menu entry Selectionsis not disabled (grayed out),
point to it to expand the available selections. If the shortcut menu
entry Selectionsis disabled, select Propertiesin the menu instead.

6. Click on the control setting of your choice to complete setting up
the control.

7. Inthe Properties dialog box, typein avalid value (for example,
200 mV for CH 1 volts).

8. Press OK to apply your selections; press Cancel to discard them.
Both buttons close the Properties dialog box.

Copy the Instrument Screen
To copy an instrument-screen image to a Notes sheet:

1. Choose File| New. The New data sheet dialog box appears
displaying alist of available data sheets from which to select.
Select Notes Sheet, and click OK.

2. Inthe Explorer view, click to first expand the list of connected
instruments, and then click the instrument whose screen you
intend to copy.

3. Click Display in the instrument resources to access the Screen
Copy icon.

4. Left click and drag the Screen Copy icon to the Notes sheet and
drop it. Theinstrument screen appearsin the Notes sheet.

Copy the Screen Image to a PC Application

1. Click thetitle bar of the Notes sheet that contains the bitmap
image you want to copy.

2. Click on the bitmap image.
3. Select Edit | Copy.

4. Display the application to receive the bitmap image and paste the
image using the application menus (usualy the Edit menu).
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Restore a Waveform to an Instrument

After acquiring awaveform, follow the steps below to restore that
waveform back to an oscilloscope that supports reference wave-
forms. Thisway the instrument can operate on the stored waveform
(displaying and using the waveform in Math functions, if supported).

1. Inthe Explorer view, click to expand the Setup branch under the
instrument to which the waveform isto be restored. This step
displays the reference location that will receive the waveform.

2. Turn on the reference location on the instrument.

3. Click and drag the waveform from a 'Y T sheet (or the data
column in tabular sheets) to the reference location in the Explorer
view that you displayed in step 1.

If you are restoring a waveform from one instrument back to a
different instrument, you need only to drag the waveform and
drop it on the new instrument icon in the Explorer view.

4. Releaseto drop the waveform and store it in the instrument
reference location.

Install/Uninstall

See Installation and Uninstallation beginning on page 1-5 for
installation and uninstallation procedures.
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Connect to Instrument (GPIB & RS-232)
1. Verify that you have the equipment listed in Table 5-1.

Table 5-1: System Requirements for RS-232 and GPIB

Required equipment Minimum requirements
] l#lgalag i
I1ga hih i
B 1
La \fhahathah
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Ba 1hh
farfid 1 @
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far @l

1 See Supported nstruments on page 1-4 for a complete list of

supported Tektronix DSOs and DPOs.

. Connect your instrument to the PC with the appropriate cable.
. Turn on the instrument power.

. If installing a GPIB connection, use the diagnostics supplied with
your Nationa Instruments software to verify the GPIB interface
inyour PC. The GPIB board is required for GPIB connection
between your oscilloscope and the PC. If you have problems
verifying your GPIB interface, refer to the National |nstruments
information.

. To add your instrument to the Instrument Manager Service, go to
one of the following proceduresin the Instrument Manager
Service section beginning on page 2-1:
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®m  Add Instrument: GPIB Connected: Use this procedure if
communicating with your DSO or DPO using GPIB
connection.

®m  Add Instrument: RS-232 Connected: Use this procedure if
communicating with your DSO or DPO using RS-232
connection.

®  Add Instrument: IR to RS-232 Connected: Use this procedure
if communicating with aTX-DMM seriesDMM.

Saving and Restoring Data Sheets

Follow the steps below to save and restore a data sheet to the current
workbook:

Save a Data Sheet

1. Select thetitle of the data sheet you want to save to make that
sheet active and bring it to the front of any other data sheets that
are also open.

2. Useone of the following methods for displaying the Save dialog:
m  Select File | Save Data Sheet.
m  Click the Save Data Sheet button in the tool bar.

®m  Right click in the data sheet area, and select Save Data Sheet
from the shortcut menu that pops up.
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3. Inthe Save dialog, enter afile name and destination for the data
sheet. Data sheet fileshave a.SHT extension.

4. Click OK to save the data sheet and close the dialog.
Restore a Data Sheet
1. Open the workbook file in which you will restore the data sheet.

2. Useone of the following methods for restoring the data sheet to a
workbook:

m  Select File | Open and select the data sheet file you want to
restore. Click OK.

m Drag the data sheet file from Windows Explorer View and
drop it on the data pane.

3. The Reconnect Links dialog appears, prompting you to select
Reconnect or Offline.

Reconnect. Select Reconnect to reconnect the links used when
the data sheet was last saved.

Offline. Select Offline to open the data sheet without restoring
the links to the original data sources.

| 1 71 . If you select Reconnect and the data source is no longer
available, a dialog will appear, and the data sheet will be opened as
an offline file (no active links).
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Saving and Restoring Workbooks
Follow the steps below to save and restore a workbook:
Save a Workbook
1. Useone of the following methods for displaying the Save diaog:
m  Select File | Save Workbook.
m  Click the Save Workbook button in the tool bar.

2. Inthe Save dialog, enter afile name and destination for the
workbook. Workbook files have a. WK extension.

3. Click OK to save the workbook and close the dialog.
Restore a Workbook
1. Useone of the following methods to restore a workbook:

m  Select File | Open and select the workbook file you want to
restore. Click OK.

m  Drag the workbook file from Windows Explorer View and
drop it on the data pane.

2. The Reconnect Links dialog appears, prompting you to select
Reconnect or Offline.

Reconnect. Select Reconnect to reconnect the links used when
the workbook was last saved.

Offline. Select Offline to open the data sheet without restoring
the links to the original data sources.

| | 71 . If you select Reconnect and the data source is no longer
available, a dialog will appear telling you so, and the wor kbook will
be opened as an Offline file (no active links).

3. If you have aworkbook already open, you will be prompted to
save. Restoring a saved workbook file closes the current
workbook file.
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Converting WSTR31 Notebook (*.nbk) Files

To convert aWSTR31 (WaveStar for Windows 3.1) notebook file to
aWSTRO (WaveStar for Oscilloscopes) workbook file, do the
following procedure:

1. Start the WSTRO program.
2. Select Open from the File menu.

3. IntheFilesof typefield (near the bottom of the Open dialog),
select WaveStar 3.1 Notebook Files (*.nbk).

4. Locate the notebook file you want to convert.
5. Click Open.

The notebook sheets are converted and appear in the data sheet
pane.

6. Usethe Save Workbook as... selection in the File menu to save
the converted notebook sheets as a new workbook.

Differences in Converted Files

The following notebook datais not converted to the new Workbook
format:

m Waveform notesin YT and XY data sheets

The following differences may occur in the display of your data:

m  Higher resolution waveform drawing methodology may cause
waveforms to appear dightly different when viewed at high zoom
percentages.

®m YT datathat was displayed in the dot format is displayed in the
vector format.

®m  Graticule divisions are scaled the same both vertically and
horizontally. During the conversion, the graticule is scaled
according to the horizontal scale selected in the notebook.
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The position of text, the text font, and the text color on converted
data sheets may be different than on the original data sheets. The
text ismovable and you can easily reposition it. You can also
select the font you want displayed and the font color.

Grayscale is now selected from the Print Setup.

YT and XY datais displayed at 100% zoom.

Cursors are not displayed onthe YT and XY data sheets.
All waveforms are visible on the YT data sheet.

Saving and Printing Repetitive Snapshots of Data
(“Babysitting” or Untended Monitoring Mode)

The Save, Print, and Refresh buttons in the main toolbar accept
linked data. This allows you to save, print, or refresh the data sheet
or workbook when the data source updates, even if you are not
sitting at your PC. Follow the steps below to link data sources to one
of these buttons:

5-16

1

Select adata sheet that has linked data. While you can link data
to atoolbar button directly from the Explorer View, dragging it
first to a data sheet allows you set the name of the saved data
sheet or workbook file.

If you plan to save repetitive snapshots of your data, you should
choose the Autoversioning option from the File menu. Selecting
this option adds an automatic date and timestamp to the saved
filename, which prevents new files from overwriting previous
ones.

Right click and drag the data source to the toolbar button. When
you release the mouse button, select Link in the shortcut menu
that pops up. (You can aso press Ctrl+Shift and left click and
drag the data source to the toolbar button.)

To view or delete alink from a data sheet or toolbar button, right
click on the sheet or button and select Show Links from the shortcut
menu that pops up. The Show Links dialog appears allowing you to
select and delete links.
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Viewing Long Record Lengths

You can view and export long record lengths with up to 8 million
sample points. The procedure for viewing long record lengthsis the
same as for viewing any waveform data, with the exception of the
PC memory required to download or export the data.

The following table lists memory requirements to download and
export waveform record lengths of 4 million and 8 million points.
Using less memory than the table indicates requires WaveStar to do
extensive disk cache swapping, resulting in process times from
minutes to hours. If you plan on working with long record length
files, install RAM into your PC to meet (or preferably exceed) the
minimum memory reguirements listed in the table.

Minimum RAM re-
quired to download

Minimum RAM re-
quired to generate

Record length from oscilloscope export file
B 1B
B LB

To print the full record length of all waveformsin the YT data shest,
select the data sheet and choose Print Banner... in the File menu. The
Print Banner option is useful when your YT data sheet contains
waveforms that are longer than the width of the graticule.

Exporting Data

You can export data from any of the data sheets as either comma-
separated values (CSV), text, or rich text format (RTF). You can aso
export waveform mask test files (MSK) from YT data sheets. Refer
to Importing/Exporting a Mask on page 4-42.

1. Select the data sheet from which you want to export data.

2. Select the dataitems within the data sheet that you want to
export.

3. Select the File | Export menu command.
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4. Inthe Export dialog, select the format for the exported data and
click OK.

m  CSV: Comma-separated values
m  Text: ASCII text format
m  RTF: Rich text format

5. IntheFile Save Asdiaog, enter afile name and location for the
export file, and click OK.

While the export is running, a counter is displayed that shows how
many records have been exported and written to the export file.
Click Stop at any timeto stop the export. Thisis especially helpful
when exporting long record lengths.

When displayed, datain the export file looks exactly like what you
would get if you dragged and dropped the data to Microsoft Excel or
Word, except using the Export command writes this datato afile
instead of displaying it in an external application.

Importing Data

5-18

You can import instrument-generated waveforms files with WFM,
ISF, or CSV formats, as well as waveform data stored or created in
Microsoft Excel CSV format. You can import waveform datato YT,
XY, WaveformM easurement, and WaveFormTabular data sheets.

You can also import waveform mask test files (MSK) to YT data
sheets. Refer to Importing/Exporting a Mask on page 4—42.

Importing data method 1:
1. Select the data sheet to which you want to import data.

2. Select the File | Import command. WaveStar displays the Import
File dialog box.

3. Select or enter the name of the file to import.
4, Click OK. WaveStar imports the data into the selected data sheet.
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Importing data method 2:

1. Inthe Windows environment, select the file that contains the
waveform data to import.

2. Drag and drop the file onto the data sheet to which you want to
import data.

CSV Format

CSV files can have no more than two lines of header information,
followed by two columns of time/value data. The followingisan
example of the CSV format:

[YTSheet (1).CH1]
S,Volts
-0.024984,0.108438
-0.024944,0.0615625
-0.024904,0.090625
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User Proxy Table Utility

The WaveStar User Proxy Table Creation Utility is an application
that helps you build instrument proxy filesinteractively. Instrument
proxy files consist of simple commands and queriesthat the utility
uses to program those instruments for which instrument proxies are
not available. You can use this utility with WaveStar Software for
Oscilloscopes.

Proxy File Overview

Instrument Proxy files are user-readable ASCI| files, with read and
write permissions enabled. Each file consists of records that describe
the commands and queries to be used to program various settingsin
the instrument. The records can also contain information on the data
type of any argument taken by the command, the response string that
will be returned by the query and read/write privileges.

The proxy table files can only contain commands and queries that
take or return simple, nonaggregate data. Commands and queries
that handle aggregate data, like arrays or structures, cannot be used
inthefile.

Records
A typical record in the file will look as follows:

add(CH1.Bandwidth), command(:CH1:BAN%s\n),
query(:CH1:BAN?\n), response(%s), type(String),
access(rw), enum(TWENTY,HUNDRED, FULL);

In the above example, the name of the setting described by the
record is CH1.Bandwidth. The string to be used to program the
setting is specified by the Command field. The string to be used to
guery the setting is specified by the Query field. The Typefield
specifies the nature of the argument taken by the command. Access
rights are specified by the Accessfield.
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Fields within arecord are separated by commas, while records
themselves are separated by semi-colons.

Initialization Commands

You can specify aset of initialization commands in the file, which
the WaveStar application will use to initialize the instrument during
the process of establishing a connection. Initialization commands are
preceded by the keyword ‘init’, while normal commands are
preceded by the keyword ‘add’.

A typical initialization command looks as follows:
init(:CH1:BAN TWENTY\n);

The WaveStar application will issue the above statement to the
instrument at the time of establishing the connection, setting the
instrument bandwidth to TWENTY. You can specify multiple
initialization records, but you must separate them with semi-colons.
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Main Screen

When you open the User Proxy Table Utility, the application opens
the main screen. Thisdialog is used to add a new record or modify
an existing record. For anew file, the list box and controls will be
empty. If you open an existing file the list box will display the
records in the file and the controls show corresponding fields of the
first record. The columns of the list box correspond to the different
fields comprising arecord.
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File Menu

Hew Clrl+r
Open... Chrl+0
Save Clrl+5
Save bz, Clrl
Setting. .. Chl+T
1 Instrument] . ipr

E it

New. Select New to open anew main screen with no recordsin the
list box. The application can open only onefile at atime, so if you
select New, the currently open file will be closed (you will be
prompted to save thisfile beforeit is closed). By default, new files
aretitled Instrument 1.

Open. Select Open to open a previously saved file.

Save. Select Save to save the open file to a directory. Files are saved
with an .ipr extension.

Save As. Select Save Asto save the open filewith anew nameor ina
new location.

Settings. Select Settings to open the User Proxy Registry Settings
dialog. See Registry Screen on page 6-9 for further information.

<Recent Files>. This section of the File menu displays all recently
opened files.

Exit. Select Exit to close the application.
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Record Menu

EEIZ:I:Ird
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Cut Alk+
Copy Alk+C
Easte | Fh

Initighization Record  Chrl+l
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End Clrl+01

New. Select New in the Record menu to commit (save) the current
record and clear the controls for entering a new record. If you were
modifying the current record, you must first click Update to update
the record file; otherwise the modifications will be lost. Records are
saved to file in the same order they are displayed in the list box.

Cut. Select Cut to cut the selected record from the list box. The cut
record is put on the clipboard.

Copy. Select Copy to copy the selected record.

Paste. Select Paste to paste the record in the clipboard to the list box.
Therecord is pasted above the currently selected record in the list
box.

Initialization Record. Select Initialization Record to open the
Initialization Commands dialog. See Initialization Screen on page
6-8 for further information.

Home. Select Home to select the first record in the file and show the
corresponding controls.

End. Select End to select the last record in the file and show the
corresponding controls.
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Help Menu

Select About Proxythl... in the Help menu to display the About
Proxytbl dialog showing the product name, version number, and
copyright information.

Toolbar
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Toolbar Buttons

There are four toolbar buttons in the main screen that control the
current record (see theillustration on page 6-3):

New. Click this button to insert a new, blank record above the
currently selected record.

Update. Click this button to commit (save) the current record. Any
changes you have made in the controls will appear in the list box.

Clear. Click this button to clear the edit controls and entry fields.

Cut. Click this button to cut the currently selected record from the list
box. The cut record is placed on the Windows clipboard.

Control Settings

There are nine control settings in this dialog that allow you to
control the record.
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Setting. This control specifies the name of the instrument setting
described by the record.

Command. This control specifies the command to be used to program
the setting in the instrument. The command control is disabled if the
access control is set to read-only.

Query. This control specifies the query to be used to read the setting
from the instrument. If you do not specify a query control, the
response control is disabled. The query control is disabled if the
Access control is set to write-only or execute.

Response. This control specifies the type of response expected when
the setting is queried. This control isdisabled if no query control is
specified.

Access. This control specifies the read/write access of the setting.
Settings with write-only access cannot be queried. You can not write
to settings with read-only access. Read settings disable the command
control. Write settings disable the query and response controls.
Execute settings set the Data type control to Method and disable all
controls except Setting, Command, and Data Type.

Data Type. This control specifies the type of argument that the
Command control will take. For Method data type settings, the
Access control is set to Execute.

Enum List. This control is used to input comma-separated enumerated
values. These values must be comma-separated.

Units. This control specifies the units to be associated with the
setting.

List Box. Thelist box displays the partial set of recordsin the
currently open file. You can view any record in the file by selecting
therecord in the scrolling list.
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Initialization Screen

The Initialization Commands dial og has a scrollable edit box that
displaysinitialization commands that have been previously entered
or read from the Initialization Section of thefile.

You can add, delete, and modify theinitialization commands. Each
command has to be entered on anew line. Click OK to save the
initialization commands and store and add them to the Initialization
Section of the file when thefileis saved. Click Cancel to dismissthe
dialog without saving changes.
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Registry Screen

Use the User Proxy Registry Settings dialog to enter registration
information for thefile. You can access the Registry Settings by
selecting Settings from the File menu. The dialog is also displayed
when you save or closethefile.
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If thereis an entry for the current file in the registry, the valuesin
this entry are read and displayed in the dialog; otherwise the dialog
is brought up with default valuesin the fields. You can modify these
values and overwrite the existing registry entries.

At startup, the application checks the registry to seeif thereis any
top-level key containing the UserProxyProgld (“ Ul ser.InstrConnec-
tion.1") and Type (0x796e6164). If such key is unavailable, the
utility createsit, and updates LastProxyld. If necessary, the
application builds the whole Software\Tektronix\InstSvr\Available
Proxiestree under HKEY _LOCAL_MACHINE key.

|71 Ifthereisno registry entry under the UserProxy top-level key
corresponding to the file name being edited, the application creates a
new entry with the same name as the open file and saves the settings
under it.
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There are four entry fields and two buttons that control the User
Proxy Registry Settings dialog:

Instrument Family Member Name: This field displays the name of
thefile that is being registered.

VISA Filter: Thisis auser-editable field that shows the value of the
VisaFilter registry key if available. This key determinesthe
communication (GPIB or RS-232) settings of the instrument. If
thisregistry key is not available, this field shows, by default,
GPIB?*INSTR:ASRL?*INSTR.

VISA Defaults: Thisis a user-editable field that shows the value of
the VisaDefaults registry key if available. Thiskey determines
the default RS-232 baud rate, data bits, parity, and flow control
settings of the instrument. If this registry key is not available, this
field shows, by default,
VI_ATTR_ASRL_BAUD=9600,VI_ATTR_
ASRL_DATA_BITS=8,VI_ATTR_ASRL_PARITY=0,
VI_ATTR_ASRL_FLOW_CNTRL=2.

VISA Settings: Thisis a user-editable field that shows the value of
the VisaSettings registry key, if available. Thiskey determines
the user-edited baud rate, data bits, parity, and flow control
settings of the instrument. If thisregistry key is not available, this
field shows, by default,
VI_ATTR_ASRL_BAUD=9600,VI_ATTR_ASRL _
DATA_BITS=8VI_ATTR_ASRL_PARITY=0,
VI_ATTR_ASRL_FLOW_CNTRL=2.

OK Button: Click this button to save currently displayed registry
settings and close dialog.

Cancel Button: Click this button to dismiss the dialog without
changing the registry settings.
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This section provides instructions to set the default RS-232 values on
various Tektronix oscilloscopes and some general troubleshooting
help.

Setting RS-232 Default Values

Refer to the information in this section for RS-232 interface
connections for your specific oscilloscope family.

TDS 200, TDS 300, TDS 3000, and THS 700 Series

If you areusing a TDS 200 Series, TDS 300 Series, TDS 3000
Series, or THS 700 Series oscilloscope, you can use the Set RS-232
Parameters to Default Values button to set the RS-232 settings on the
oscilloscope to the WaveStar default values.

TDS 200 Series Oscilloscopes. Follow the steps below to access the Set
RS-232 Parameters to Default Values button:

1. Pushthe Utility button on your oscilloscope.
2. Push the Options bezel button.

3. Push the RS232 Setup bezel button.

4

. Push the Set to defaults bezel button to set the RS-232 settingsto
the WaveStar default settings.

You can examine the Error Log for clues about your RS-232
interface connection. Follow the steps below to access the Error Log:

1. Push the Utility button on the oscilloscope.
2. Push the Error Log bezel button.
3. Usethe bezel buttons to page through the Error Log display.

Check thelinesin the Error Log titled RS-232 Line Snapshot and
RS-232 Errors. Refer to the programmer manual for your oscillo-
scope for information about interpreting the information in the Error
Log.
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TDS 300 Series and TDS 3000 Series Oscilloscopes. Follow the steps
below to access the Set RS-232 Parameters to Default Values button:

1
2.
3.

Push the Utility button on your oscilloscope.
Push the bottom left bezel button repeatedly until 1/0 is selected.

Push the RS-232C (RS232 for the TDS 3000 Series) bezel button.
The side bezel buttons now control the RS-232 settings.

Push the fourth bezel button (fifth bezel button for TDS 3000
Series) on the side to set the default RS-232 settings to the
WaveStar default values.

You can examine the Error Log for clues about your RS-232
interface connection. Follow the steps below to access the Error Log:

1.
2.

Push the Utility button on the oscill oscope.

Push the bottom left bezel button on the oscill oscope repeatedly
until Diag is selected.

Push the bezel button on the oscilloscope labeled Error Log.
TDS 3000 Series oscilloscopes display the Error Log. (For TDS
300 Series oscilloscopes, push the side bezel button labeled
Display Log to display the Error Log.)

Check thelinesin the Error Log titled RS-232 Line Snapshot and
RS-232 Errors. Refer to the programmer manual for your oscillo-
scope for information about interpreting the information in the Error
Log.

THS 700 Series Oscilloscopes. Follow the steps below to access the Set
RS232 Parameters to Defaults button.

1.
2.

Push the Utility button on the oscill oscope.

Push the bottom Ieft bezel button (System Config) on the
oscilloscope repeatedly until RS-232 is selected.

Push the fifth bezel button on the oscill oscope (1abeled Set
RS232 Parametersto Defaults).
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You can examine the Error Log for clues about your RS-232
interface connection. Follow the steps below to access the Error Log:

1. Push the Utility button on the oscilloscope.

2. Push the bottom left bezel button on the oscill oscope repeatedly
until Diag is selected.

3. Push the bezel button on the oscilloscope labeled Error Log.

4. Push the adjacent bezel button labeled OK Display Log to
display the Error Log.

Check thelinesin the Error Log titled RS-232 Line Snapshot and
RS-232 Errors. Refer to the programmer manual for your oscillo-
scope for information about interpreting the information in the Error
Log.

TDS 400, 500, 600, 700, or 800 Series

The TDS 400, 500, 600, 700, and 800 Series oscilloscopes support
RS-232 printers but cannot be controlled over the RS-232 interface.
WaveStar Software can only communicate with these series of
oscilloscopes using a GPIB interface connection.
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RS-232 General Hints

m  Make sure the communication parameters are set correctly on
both the oscilloscope and WaveStar. Baud rates should be the
same, Parity should be None, Data Bits should be 8, and Stop
Bits should be 1.

[ 11 . Soft flagging should never be used for waveform and
hardcopy transfers. This is because waveform data and hardcopy
output contain binary characters which can easily include the XON
and XOF F charactersused to implement soft flagging. Soft flagging
should only be used for transferring stored setups since stored setup
information generally consists of printable ASCII text.

m  Although it generally should not matter if the EOL characters are
the same, set the EOL to CRLF to be sure there are no problems.

= Not all instruments support full RS-232 communications. Some
instruments only support GPIB communication, while others
support limited RS-232 functions, such as printer functions.

m If you are able to connect to an instrument but unable to transfer
waveforms successfully, you may have a cable that is not wired
correctly for hard flagging.

If you can successfully transfer settings to and from the
instrument at the fastest supported baud rate, hard flagging is
probably working. If not, try soft flagging. If you can successful-
ly transfer settings using soft flagging but not with hard flagging,
there is agood chance the hard flagging lines of your cable are
not connected properly.
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RS-232 Cable Issues

If the information provided so far in this section fails to resolve your
RS-232 problems, try the following information:

® You might be using an incompatible RS-232 cable. Thereisno
such thing as a standard RS-232 cable, so you may need to use an
ohmmeter to verify that your cableiswired correctly. Many
cables do not have all of the pins connected.

m  Determine whether the PC and oscilloscope are DTE (Data
Terminal Equipment) or DCE (Data Communications Equip-
ment) devices. Thisinformation is in the documentation provided
with your oscilloscope and with your PC.

m If you are connecting a DTE device to a DCE device you will
need a straight-through cable. Thisis a cable that has the same
pin assignments on both ends of the cable.

m |f you are connecting two devices of the same type, you need a
null modem cable. Thisis a cable whose lines are crossed such
that the inputs of one device are connected to the outputs of the
other.

» L1111 Do not connect the output lines of two same-type devices
! to each other. Doing so will damage one or both of the devices.

m  For hard flagging to work, the RTS (Request To Send) and CTS
(Clear To Send) lines must be connected. Use an ohmmeter to
verify that they are actually connected since not all cables
connect these lines. The RTS lineis sometimes referred to as
RFR.

® TheDCD (Data Carrier Detect) lineis not used by WaveStar o it
does not matter whether or not it is connected. The DCD lineis
sometimes referred to as RLSD.
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RS-232 Cable Examples

Theinformation in this section provides correct wiring and pin
assignments for RS-232 interface connections with each type of
oscilloscope supported by WaveStar Software.

TDS 200, TDS 300, & TDS 3000 Series Oscilloscope to PC (DB9 to DB9)

Table 7-1 lists the correct wiring for connecting a TDS 200,
TDS 300, or TDS 3000 Series oscilloscope with 9 pinsto a9 pin
seria port on aDTE PC. These oscilloscopes are DTE devices.

Table 7-1: Pin assignments for TDS 200, TDS 300, and TDS 3000

Series oscilloscopes (DB9 to DB9)

DB9 connec-
tor pin
number (to

DB9 con-
nector pin
number

TDS line oscilloscope)

(to PC) DB9 signal name

1 Pins 1 and 8 are wired together.
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Connecting Two Like Devices (DCE to DCE or DTE to DTE)
Using Null Modem Cable

Table 7-2 lists the correct wiring for connecting two like devices
together using a DB25 female to DB25 female cable.

Table 7-2: Pin assignments for DB25 Female to DB25 Female Null

Modem Cable

DB25 fe-
DB25 female 25 pin | male pin
connector number PC pin Line name
hai i hai i

1
1

iga iga

1 Pins 6 and 8 are wired together.
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GPIB Overview

Most GPIB problems are caused by the genera errorslisted in
Table 8-1 lists common GPIB problemsand .

Table 8-1: Common GPIB Errors

Problem Solution

ra

IgiB Az

1 afiB | gallaami gl
i a
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If you experience problems using GPIB communication, use the
steps below to try to resolve the problem. Usually, problems have a
simple cause such as an incorrect address or faulty cable. If the
procedures below or other GPIB-related help information does not
fix the problem, contact Tektronix Technical Support for further
help.

First, make sure you are using the proper equipment to establish the
GPIB connection:

m  National Instruments GPIB Interface card (IEEE Std 488.2)
Version C.12 or later

m GPIB Cable

After verifying you are using the proper GPIB equipment, follow the
steps below.

1. Disconnect all GPIB cablesfrom PC.

2. Run the hardware diagnostics supplied with the GPIB card.
3. Run the software diagnostics supplied with the card.
4

. If the GPIB diagnosticsfail, or if you have difficulty running
them, contact National Instrument Technical Support.

5. If the GPIB diagnostics pass, contact Tektronix. (See page
NO TAG for information on how to contact Tektronix.)
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